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1. Introduction 

The purpose of this document is to explain how to use Project Organiser and its available functions. 

This document will explain how Project Organiser is used for configuring a system.  It will give details 
concerning the items, that represent the configuration of the system, presented in the tree and list 
views within Project Organiser.  It will also explain what parts of the system configuration the 
applications (associated with the items in the Tree View via the Application Toolbar) can be used to 
configure. 

The Tree View within Project Organiser represents the configuration of a system, although due to 
the limitations of a Tree View not all the system is represented.  By using the available property 
pages, displayed via the floating menu, and the applications associated with the Tree View items, a 
user can access all the configuration of a system from one central environment.  It also allows 
additional Tree View items to be created or deleted, that can then be allocated using the copy and 
paste commands or, more easily, dragged and dropped within the Tree View items. 

Note 
Each application that can be launched from the Project Organiser has related documentation. 

Contact your distributor if these documents are unavailable. 
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2. Overview 

Overview of the Project Organiser 

Why the Project Organiser ? 

Project Organiser provides a central managed environment for configuring and maintaining a 
Project.  A large part of the system configuration, particularly those involving assignment of Tags to 
functions, can be configured directly from within Project Organiser.  Where further configuration is 
required, an item displayed in the Tree View will allow an Application to be launched from the 
context-sensitive Application Toolbar.  Use the System Checking Tool to validate an installation and 
configure selected default parameters in a Project. 

The top-level items in the Tree View represent different fixed aspects of the system configuration. 
 Within these top-level items new items can be created and existing items can be copied from other 
parts of the system configuration.  User created items may also be renamed or deleted.  Some items 
in the Tree View have a property page allowing the configuration of related information. 

Some aspects of system configuration are more complex than a simple property page and may 
require access to additional Applications.  When an item in the Tree View is selected the user will be 
shown a list of related applications in the Toolbar, immediately above the Tree View. 

Tip! 
Use the BUILD command to ensure the Project Database contains all the latest configuration 

changes before the system is started. 

 

The top-level item in the Tree View represents the Project and the Application Toolbar shows the 
Applications that are relevant to the entire project.  As each item is selected the relevant Applications 
appear on the Application Toolbar.  When the Application is launched via the Application Toolbar, it 
operates as an independent program as opposed to being contained by the Project Organiser 
window. 

The List View that appears to the right of the Tree View is used exclusively for showing Tags.  This 
allows Tags to be selected so that they can be copied to other configuration items in the Tree View. 
 It is also a useful means of just viewing the system configuration. e.g. What Tags are in a particular 
instrument. 

Note 
A Deployment Toolbar allows the Project, including the Security database, to be deployed to other 

computers within a multiple computer system, and the current deployment status to be viewed. 
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Eurotherm Project Studio 

Projects are systems configured using Eurotherm Project Studio software. 

Refer to… 
Eurotherm Project Studio User Guide & Tutorial, in Online Books, for full details. 

 

 

What is a Tag ? 

A Tag is a concept that is configured to represent 

 any Generic Tag, including 
• an individual data field or subfield, (Field Tag) 
• a generic I/O point, (I/O Tag) 
• a LIN function Block, (Block Tag) 
 or a standard LIN Control Module Tag, (Control Module Tag). 

Note 
A Tag can also be left in its pre-configured state as a ‘placeholder’, usually until more 

is known about its use. 

Each Tag requires some level of security.  This is defined by an Access Level, which is a 
numeric value between 0 and 32767, but may also be entered as an Access Level 
Enumeration, that denies write access to that Tag by any User with an insufficient Access 
Level User Rights.  A User attempting to write to that field requires an Access Level equal 
to or greater than this value. 

Beware 
Users allocated to a User Group MUST be configured with a sufficient Access Level 

User Rights in the Security Manager Utility before a Tag in a Tag Security Area can be 
amended. 

Failure to do so will result in the write access being denied. 
To resolve this problem, 

Use the Security Manager Utility to ensure the User Group is configured with a 
sufficient Access Level User Rights. 

During runtime the InTouch Supervisory Computer can only display appropriate 
information from correctly assigned Tags. 

 

Field Tags 

Any Generic Tag representing a field in a Block has a pre-configured Access Level. 

 

Control Module Tag 

A Control Module is a collection of sensors and logic that, from the point of view of the 
operator, are a single piece of equipment. The Control Module forms the interface to the 
plant and makes the higher level activities of the system simple as it provides services to 
ensure an activity is completed. 

It is typically centred on a small piece of control equipment.  The Control Modules are 
probably already known, and can be referred to as devices.  Several Control Modules will 
usually be found on a single P&ID, each with it’s own TagName.  To provide I/O for the 
Control Module there are usually several other TagNames. 

Example 
Control Modules are valves, PID loops and motors/pumps. 
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In the LIN system, a Control Module is represented by a Block Tag, although supporting blocks may 
sometimes be present. 

Access Level enumeration's 

Numeric values may be entered instead of the enumeration’s. 

Enumeration Value Level of Restriction 

Read only 0 (Most Restricted) 

Limited 1000  

Operator 8000  

Engineer 16000  

Supervisor 24000  

All 32767 (Least Restricted) 

 

Tag Security Area Specifics 

Tag Security Areas allow the system to be classified into sets of data Tags, each set 
having special significance from a security aspect. A Tag Security Area can contain any 
set of Tags, but a Tag can only be assigned to one Tag Security Area. 

Each data field of the Tag to be protected is assigned by Tagname to a Tag Security Area. 
These often, but not always, coincide with the functional or physical areas defined by the 
system, as generally Plant Units have fields that must be protected from unwarranted 
changes. 

Example 
A Feedwater preheat (Tag Security Area). 

All relevant Tags in the Feedwater preheat Plant Unit can also be assigned to a 
Feedwater preheat Tag Security Area, and all Tags throughout the system 

associated with trip settings may form a single Trip Settings Tag Security Area. 

The defining security parameter of the Tag Security Area is the Access Level User Rights, 
configured in the Security Manager.  This security parameter indicates the level of access 
required by a User in the allocated User Group to edit the Tags in this Tag Security Area. 

 

Tag and Function Block specifics 

If the system includes Tags and function blocks it is important to have an understanding of the 
following features and how they relate to the Project Organiser. 

 Tag Security Areas  
User groups are given Access Levels to Tag Security Areas.  This determines the privileges 
required in order to write to the Tags in the Tag Security Areas in the selected Security zone. 
 The Access Levels are defined as part of the Access Rights given to a User group. 

Note 
In systems that precede the Security Manager, these were known as Security Areas. When 

upgrading systems it is IMPORTANT not to confuse Tag Security Areas with Security zones. 
 Tag Profile Configurator  

The fields in a function block referenced by a Tag have a number of properties, including flags to 
indicate Electronic Signatures are required.  By default these properties are contained in the 
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template that describes the block.  However, the Tag Profile Configurator can redefine these 
properties so that they are unique for each Tag. 

 LINOPC Security  
LINOPC applies its own security check to confirm that a client has the Access Level necessary 
to write to an online block.  This is based on user names and Tag Security Areas.  However 
some client processes do not refer to block by their Tags, and do not explicitly specify user 
names, LINTools and OPCScope are two examples.  The installation sets up the necessary 
information for known clients, however where a new OPC client is being integrated it is 
necessary to understand how LINOPC deals with security. 

 TagEdit and ESDataSrv user account  
When TagEdit is activated from one of the Project Developer tools, the User is not required to 
login.  In this mode TagEdit uses ESDataSrv the default system User Id.  ESDataSrv is one of 
the default accounts supplied with the Security database and must be given access to the Tag 
Security Areas to ensure TagEdit has the privilege to perform writes when security is enabled. 

 

Tag Profile Configurator specifics 

Each field associated with a Tag has actions relating to security which must be completed before 
any changes can take effect. 

By default these values are defined on a block type basis, however this configurator allows new 
pseudo LIN Block types to be created. The new types have the same LIN Template, i.e. fields as the 
original type, but security and other attributes stored in the Project database can be changed from 
the default values. The new type is identified using the block type name, e.g. ‘PID’ plus a PointDisp 
name other than default, e.g. Boiler. Once the new type has been created in the Tag Profile 
Configurator the PointDisp field can be changed in TagEdit. Opening Tag Profiles in the Project 
folder runs this configurator which can also be used to configure various other field properties. 

LINOPC Security specifics 

Online LIN data is accessed through the LINOPC server.  This program provides an OPC interface 
to the LIN Blocks.  Through this interface LIN items are always referred to by their Fully Qualified 
Address (FQA) (Default LIN Access). 

<Port name>’’NN:<Lin DB name>.<Block name>[.<Field name> | .<Sub field name> | 
.<Qualifier>] 

where, 

NN = LIN node address in hex. 
Or if a Project database is available, items may be referred to using their Tags, 

<Tag name>[.<Field name>][.<Sub field name>][.<Qualifier>] 

By default, LINOPC takes the OPC group name to which the item was added as the User name. 
 However, if the item has the ‘.w’ qualifier, the LIN User Name is extracted from the string that is 
written to the item. 

For example, if a client wishes to write the value ‘55.6’ to the ‘PV’ field of the ‘Tag’ ‘PID01’, the client 
adds the item 

[PID01.PV] 

and writes ‘55.6’ to it. In this instance LINOPC uses the OPC group name the item was added to as 
the User. 

Alternatively if the client wished to specify User ‘Jack’ on computer, i.e. ‘OpStn1’, signed for the 
change, the item could be added with the ‘.w’ qualifier. 

[PID01.PV.w] 

A ‘.w’ string value which has the following syntax would then be expected. 

[<PC Node>],[<User data>],[<Access level>],[<Qualifier>],[<Value type>:]<Value>[0] 

Where 
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<User data> [Logged on user] / [Signing user] / [Authorising user] 
Currently only the [Logged on user] or the [Signing user] is used.  The Access Level is checked 
against the [Signing ‘User’] if present. 

 

Value Description 

<Access level> If this value is specified it overrides the Users Access Level to the Tag 
defined in the security database. 

<Qualifier> not used 

<Value type> <s | d | f | x | 
o> 

 
<s>= string 
<d>= integer 
<f> = floating point 
<x> = hex 
<o> = octal 

Example 
OpStn1, /Jack/, , ,f,55.6 

 

What is OPC (Open Process Control) ? 

Open Process Control (OPC) is a single, industry-standard interface that allows a combination of 
different devices from different manufacturers to share information around Networks in one system. 
 Factory, laboratory and office applications can all access the same data as any number of OPC 
software applications can simultaneously read a device. 

OPC can reduce installation and any downtime time by allowing devices to be added, or replaced 
 with a device from another manufacturer, without stopping existing software and systems. 

Default LIN Access 

If the client is addressing the LIN Blocks using Fully qualified addresses then LINOPC will not have a 
Tag Security Area for the block, and consequently will be unable to determine if the User has 
sufficient Access Level when writing to the blocks.  LINtools Engineering Studio and OPC Scope are 
examples of such clients. 

In this instance LINOPC uses the default LIN access defined in the ‘defaccss.CSV’ file.  Each line of 
this file has the following format. 

<User name>, <RO | RW> 
Where  

RO = Read only 
RW = Read write 

LINOPC looks for this file first in the active Project folder, and then in the folder containing the 
Linopc.exe file. 

If LINOPC has to use the security defined in this file then a user will be granted either ‘RO’ or ‘RW’ 
access, irrespective of the block being written. 

Default LIN User Names 

Unless the item being written to was added using the ‘.w’ qualifier, LINOPC will use the OPC group 
name as the User name. 

If it is not already known, it is possible to determine the OPC group names that have been created in 
LINOPC by running the LINOPC Groups application. 

Some clients may not specify a group name in which case LINOPC automatically creates group 
names of the form AutoGroup<nn>. 
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If these applications are also using ‘Fully qualified addresses’ it will be necessary to add these group 
names into the ‘defaccss.CSV’ file.  For the clients that have group names automatically created the 
user name AutoGroup will need to be added, and will apply to all these clients. 

After installation ‘defaccss.CSV’ will normally be configured with the lines 

LinToolsOpc.<Logged in NT user>.<PC node name> , RW 
TheGroup, RW  

This defines the access for the clients LINtools Engineering Studio and OPCScope. 

TagEdit and ESDataSrv user account 

When TagEdit is used with the configuration tools the User does not have to login, instead TagEdit 
uses the system User Id, ESDataSrv. The ESDataSrv account can be created when adding a 
Security item. Therefore if security is enabled, it is necessary give ESDataSrv the necessary Access 
Levels to the Tag Security Areas. 

What is the System Checking Tool ? 

The System Checking Tool is a wizard based tool designed to permit both the system and individual 
sections of an installation to be validated.  The status of each section of the installation is identified 
via icons. 

A successful configuration is indicated by the Tick (green), whereas the Exclamation Mark indicates 
that a wizard can be launched to configure the specific section.  The 'i' shows the section displays a 
concise list of information only. 

Note 
If specific sections are not configured, default parameters can be configured using additional wizard based 

commands. 

So to summarise the System Checking Tool is used to, 

 configure a default installation via a set of wizards 
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3. Configuring a Project 

Tip! 
Use the System Checking Tool to initiate a wizard used to configure a set of default installation 

parameters. 

Configuring a Project involves creating new items within the Tree View of Project Organiser and 
configuring the properties of those items.  Some items can be seen in multiple 'branches' of the Tree 
View.  This is because they can be contained within, or referenced by, different aspects of the 
system configuration.  Plant Units, for instance, are created below Process cells within the Plant 
Model but can also be contained within an Alarm Group or a Security Area. 

When a Project is initially created via the New Project Wizard, the User is presented with the view in 
Project Organiser.  It can only present the information supplied by the User, and therefore if 
insufficient information is available further configuration of the Project is required.  This can include 
creating the Networks, Instruments and Tags (possibly via the Clone Network wizard if the 
instruments already exist), then perhaps other items that allow the Tags to be grouped into common 
areas.  This can include Plant Model items, i.e. Process Cells and Plant Units, Alarm Groups and 
Tag Security Areas.  A Project does not have to be configured in any specific order, but some items, 
i.e. I/O instruments, can only be created if an instrument network exists.  When, sufficient 
information has been entered, the Project MUST be built to ensure all other applications can access 
the information.  During the build process the Report Window displays a record of each operation it 
attempts. 

Tip! 
Tags and Items can be assigned to a destination within Project Organiser using copy and paste, or 

drag and drop. 

Note 
Each new item, and all subsequent items, and Tags can be created using the New... wizard and, configured 

using the context sensitive Tools... command available from the floating menu. 

Project 

The top-level item represents a single Project and contains all the other items in the Tree View. 

Note 
Some Projects will not require the configuration of ALL items shown in the Tree View.  It is possible that a 
Project does not require a Computer, therefore the Computer, Displays and Trended items can be ignored. 

A property dialog allows the active Project and Master Project data to be configured. 

All Tags 

The All Tags item is a container for ALL the Tags in the Project.  Tags are simple to understand as 
they are a reference point to a specific part of the system. 

The Tags can be managed using the Tags menu.  The floating menu allows parameters of a 
selected Tag to be configured via the Edit Tag. 

Note 
Each Project Type has a default maximum number of Tags that can be increased using the Licence Utility. 

Networks 

The Networks item is a container for the instrument networks and will usually map onto Computer 
ports. 

The LINOPC Control Panel can be used to create Ports prior to creating a Project that will simplify 
the Network configuration.  If the New Project wizard is run after the LINOPC Control Panel has 
been used to create the Networks, all associated Network items will automatically appear in the 
Project. 

Tip! 
It is good practice to, where possible, keep the network names and port names the same. 

Network 

A Network item represents a single instrument network, usually a Local Instrument Network, LIN.  It 
contains instrument items that represent live instruments that can be directly communicated with on 
the Network. 
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The property page allows the online port (LINOPC port) to be configured for the Network, allowing 
the Network to be used when monitoring instrument databases. 

Instrument 

An Instrument item represents an instrument on the Network.  It contains the I/O Networks relating to 
this instrument, such as Modbus, Profibus or EI-Bisynch, and the instrument control strategy files 
that can be shown using Windows Explorer, Project > Explore Project, but can be accessed from 
the LINTools Engineering Studio button in the Application Toolbar. 

The LINtools Engineering Studio is used to configure and monitor an instrument. 

The property page allows some items, i.e. LIN Node address, to be modified so it corresponds to the 
LIN Node address of the live LIN instrument. 

Instrument Network 

An Instrument Network item represents either a Modbus, Profibus, or EI_Bisynch Network 
communicating with an I/O instrument from a LIN instrument.  It contains instrument items that 
represent live I/O instruments. 

The property page of an Instrument Network allows the online port to be configured for use when 
monitoring instrument databases, and the selection of the I/O port for instruments that support 
multiple ports. 

I/O Instrument 

An I/O Instrument item represents an instrument that can communicate directly with another 
instrument via the Instrument Network.  An I/O instrument is normally used to provide inputs and 
outputs for the use of the control strategy within the master instrument. 

The iTools Engineering Studio is used to configure and monitor the instrument database. 

Plant Model 

The Plant Model item is a container for Process Cells, and is used to define divisions of a system. 

Tip! 
The Plant Model is useful as Plant Units can be assigned to Alarm Groups and Tag Security Areas, 

instead of single tags. 

Process Cell 

The Process Cell item is a container for Plant Units.  It contains all the Plant Units that together will 
form a discrete part of the process or system. 

The property page allows a name and description to be entered. 

Plant Unit 

The Plant Unit is a container representing a particular unit of the plant.  It contains all the Tags that 
are part of that unit.  Individual Tags can be allocated to a Plant Unit, and Plant Units can be 
allocated to any number of Alarm Groups to enable alarming of all the Tags within the Plant Unit. 
 Plant Units can also be used in conjunction with Tag Security Areas, for configuring the security of 
the Tags in a Plant Unit. 

Note 
Each Plant Unit can only be assigned to a single Tag Security Area. 

The property page allows a name and description to be entered. 

Unallocated 

The Unallocated item is a container that operates as a useful filter for showing Tags that have not 
been assigned in this item and therefore are not yet considered as part of the system. 

Alarm Groups 

The Alarm Groups item is a container for Alarm Groups, and is used to clarify the location of an 
alarm.  The Alarm Group, 'Default', initially exists as the automatic destination for all new Tags.  If 
the default Alarm Group does not exist any new Tag will not be automatically allocated and MUST 
be assigned manually. 
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Alarm Group 

The Alarm Group item is a container for Plant Units and Tags.  All the Tags in the Alarm Group or 
Tags in Plant Units that are in the Alarm Group will be alarmed and associated with the Alarm Group 
at runtime. 

The property page allows the name and description to be changed, and allows the Alarm Group to 
be set as the default. 

Unallocated 

The Unallocated item is a container that operates as a useful filter for showing Tags that have not 
been assigned in this item and therefore will not yet display an alarm. 

Alarm Group Sets 

The Alarm Group Sets item is a container for a set of Alarm Groups, and is used in conjunction with 
Alarm Views that allows the view of alarms from a client computer (Operations Viewer) to be 
restricted to a number of sets of Alarm Groups. 

Tip! 
Alarm Group Sets are only used when there is a need to limit one or more client computers 

(Operations Viewer) to a partial view of the alarms in the system. 

Alarm Group Set 

The Alarm Group Set item is a container for set of Alarm Groups.  Each Alarm Group Set can be 
assigned to an Alarm View in the Computers container to simplify the configuration of the display of 
alarms. 

The property page allows a name and description to be entered. 

Tag Security 

The Tag Security item is a container for Tag Security Areas, and is used to assign a level of security 
required by Users to access the Tags. 

Tag Security Area 

The Tag Security Area item is a container for Plant Units and Tags.  All the Tags in the Tag Security 
Area or Tags in Plant Units that are in the Tag Security Area can be given a level of access from any 
number of groups of users from within Security Manager. 

The property page allows the name and description to be changed, but if the Tag Security Area is 
renamed it must also be changed in Security Manager. 

Unallocated 

The Unallocated item is a container that operates as a useful filter for showing Tags that have not 
been assigned in this item and therefore are not yet assigned a level of security. 

Computers 

The Computers item is a container for Computers that are configured as part of the system. 

Computers must be configured to run Operations Viewer within the system, and do not have to 
communicate with any Instruments in the system. 

The property page shows all the configured Access Names used by LINData and VIEW applications 
for communicating with the I/O Server. 

Computer 

The Computer item is a container for Ports and Alarm Views.  It will always contain Alarm Views, but 
Ports will only appear if the Computer is configured as a Server. 

The property page has Computer (or client) and Server property parameters.  It is important to the 
functioning of Operations Viewer and, effectively, defines the system's computer network 
architecture. 

IMPORTANT NOTE 
Configure the ports to enable communication with the instrumentation from a Server Computer. 
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Ports 

The Ports item is a container for network Ports on a Server Computer in the system. 

IMPORTANT NOTE 
When Computers are configured to operate as a redundant pair, the Ports and Network configuration of both 

Computers in the redundant pair must be identical. 

Port 

The Port item represents an actual LINOPC port on a Server Computer, and MUST be identical to 
the name of the Port, as configured on the PC using the LINOPC Control Panel. 

The property page allows the Port name to be defined and the Network name to be associated with 
the Port.  The Network name MUST be the correct one for the port. 

Note 
Network communication between Computers and instruments will fail if the Port on the server computer is 

not correctly configured. 

Alarm Views 

The Alarm Views item is a container for Alarm Group Sets.  If no Alarm Group Sets are allocated to 
the Alarm Views then all alarms will be visible when using Operations Viewer from the Computer. 

Displays 

The Displays item is a container for Display Blocks.  Each Display Block is a definition of a Mimic 
and the navigation that can be made from that Mimic.  Operations Viewer, can be used to view 
Display Blocks at runtime, via the Online > Startup menu. 

Note 
Normally, there is only one InTouch application per system. 

Displays allow a navigation scheme to be defined for mimics within the Operations Viewer.  There 
are buttons within the Operations Viewer that allow the operator to navigate between the custom 
Display Blocks, if correctly defined and linked. 

Display 

The Display item represents a mimic Display Block.  Each Display Block is a definition of a Mimic 
and the navigation that can be made from that Mimic.  Multiple display blocks can reference the 
same mimic, which may be necessary because different navigation is being used when  the mimic is 
navigated to from different positions in the display navigation. 

The property page allows extra attributes to be associated with the mimic, such as security and 
related pages.  It also allows the navigation between Displays to be defined. 

Trended 

The Trended item is a container for different trend types that record specific points in the system 
identified by the TagName. 

Note 
Any Tag can be allocated to these items, but only fields specifically designated for Trend purposes will be 

recorded. 

InSQL Trended Tags 

The InSQL Trended Tags item is a container for Tags that are to be recorded within InSQL. 

Note 
When the Tags are allocated, a build operation from the Project folder will create files that may be imported 

into InSQL to configure it. 

InTouch Trended Tags 

The InTouch Trended Tags item is a container for Tags that are to be recorded within InTouch. 

Note 
When the Tags are allocated, a build operation from the Project folder will configure the Tags to be trended 

within the Application. 

Non-Trended Tags 
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Use the Project Organiser 

The Project Organiser is used to configure the whole system.  It provides access to all 
items and applications required to manage and control the Tags associated with various 
parts of the system. 

Tags are simple to understand as they are a reference point to a specific part of the 
system, but the configuration of a system may not remain so simple when considering the 
complete configuration of a system.  However, this can be simplified by looking closely at 
the Plant Units.  Plant Units are a significant part of the system, as they generally match a 
major processing activity within the Process Cell, typically centred on a major piece of 
processing equipment.  Plant Units also identify the Alarm Groups, that in turn identify 
where an Alarm should be displayed, using a combination of Alarm Group Sets, 
Computers and Alarm Views. 

 Network Specifics 
 Plant Model Specifics 
 Alarm Groups Specifics 
 Alarm Group Sets Specifics 
 Tag Security Area Specifics 
 Computer Specifics 
 Displays Specifics 
 Trended Specifics 

 

What is a Report Window? 

This window records the operation it attempts and displays any validation warnings or errors it may 
have found. 

In most places, validation is carried out automatically, but can be manually initiated using the  

in the Application Toolbar, or the , or   in the Wondwerware Build ToolBar.  A Build 
operation involves checking that the data is complete and is consistent with the relevant files, at the 
expected location and is used to ensure all other applications can access this information. 
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.   

 

What is the License Utility ? 

This License Utility is a wizard, used to create, control and manage the License required to operate 
this Project software. 

A license defines the extents of the software, by specifying the purpose and number of function 
blocks, and therefore Tags, that can be used. 

Note 
Contact the manufacturer to request a license, after completing the information requested in the wizard. 

 

What is the LINOPC Control Panel ? 

This LINOPC Control Panel is a list of all LIN connections configured in the software.  It is used to 
control and manage each Network connection in the system, allowing new connections to be 
created, and existing connections to be edited or deleted. 

Note 
Each LIN port connection is also shown from a device perspective. 

 

What is LIN ? 

LIN is a communications protocol providing a token-passing masterless network which allows peer-
to-peer communications and file transfer. It is supported via Ethernet, Arcnet and Serial 
communications connection. 

The LIN Database groups data into blocks of related data. For example, a function block can 
represent an input, an output, a controller, and so on. The LIN configuration tool (LINtools) and 
display packages recognise different types of function block, and handle them appropriately. 
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Communications between LIN and Modbus instruments require a Gateway.  This involves the 
mapping of data from the LIN Database to the Modbus registers and digitals. 

 

What is a LIN Database ? 

A LIN Database (.dbf) is a software program that runs in a instrument on the LIN. The running LIN 
Database takes in signals from sensors in an outside entity (e.g. an industrial plant), processes them 
in specified ways, and then outputs signals to actuators in the entity to control its behaviour in the 
required manner. 

The cycle of signal input to the LIN Database, signal processing, and signal output to the entity is 
repeated continuously while the control strategy runs. 

More than one LIN instrument can be involved in controlling a single entity, but only one LIN 
Database can run in a single LIN instrument at a time. 

A LIN Database can work in conjunction with one or more LIN Sequences running in the LIN 
instrument. It can also make use of LIN Actions stored in action files in the LIN instrument. 

In LINtools, a LIN Database is represented and configured graphically as an arrangement of LIN 
function blocks interconnected by wires. 

 

What is a LIN Function Block ? 

A LIN Database (.dbf) uses a block-structured approach to configuring a control strategy, where a 
variety of ready-made function blocks perform the processing required. 

A function block is an instance of a reusable module of program code.  All function blocks exist in 
specific categories in the template library.  Each is dedicated to a particular type of processing 
operation, e.g. the ADD2 template adds two numbers.  In general, function blocks take in analogue 
and/or digital signals via their inputs, process them in a variety of ways and then pass the results on 
via their outputs.  By ‘wiring’ the function blocks together, the signals can flow between them to 
execute the control strategy. 

 

What is Modbus ? 

Modbus is a communications protocol. Instruments that communicate via the Modbus 
communications protocol require a Gateway, that can be configured either as a Modbus master or a 
Modbus slave.  It is supported via Serial and TCP communications interface. 

The Modbus communication interface is built around messages.  The format of these Modbus 
messages depends on the type of physical interface used.  The same messages are used on both 
RS232 and Modbus/TCP over Ethernet.  The same protocol can be used regardless of the 
connection type.  This permits a device to communicate with several Modbus nodes at once, even if 
they are connected with different interface types, without the need to use a different protocol for 
every connection. 

When using more versatile network systems like TCP/IP over Ethernet, the Modbus messages are 
embedded in packets with the format necessary for the physical interface.  In that case Modbus and 
other types of connections can co-exist at the same physical interface at the same time.  Although 
the main Modbus message structure is peer-to-peer, Modbus is able to function on both point-to-
point and multidrop networks. 

Modbus Messages 

Each Modbus message has the same structure. Four basic elements are present in each message. 

 Device address 
This is the address of the instrument receiving the data. 
 Function code 

This is a code number defining message type. 
 Data 

This is a block of data with additional information. 

19  HA029367 



Project Organiser User Guide 

 Error check 
This is a Numeric check value to test for communication errors. 

The sequence of these elements is the same for all messages, to make it easy to parse the content 
of the Modbus message.  The instrument configured to operate as the master in the Modbus 
network always initiates communications.  It sends a message and, depending of the contents of the 
message, a slave takes action and responds to it. Addressing in the message header is used to 
define which device should respond to a message. 

Note 
All other nodes on the Modbus network ignore the message if the address field does not match their own 

address. 

The instruments use Modbus registers and bits to structure the instrument data.  The Modbus 
registers and bits are simply a list of data points.  Generally, there is no pre-defined structuring of 
these points into blocks or loops, etc., and most implementations define the allocation of registers 
differently. 

Communications between LIN and Modbus instruments require a Gateway.  This involves the 
mapping of data from the LIN Database to the Modbus registers and digitals. 

 

What is Transparent Modbus Access? 

Transparent Modbus Access (TMA or TalkThru), allows access to an instrument operating in 
Modbus or Profibus Slave mode via an instrument operating in Modbus or Profibus Master mode, 
while communications remain between both instruments. 

A PC, running a suitable client (typically iTools or other third party Supervisory Control And Data 
Acquistion software) is connected to the appropriate LIN instrument port. The iTools software can 
then communicate with the Slave, via the Master, as if it were connected directly. Communications 
between these instruments may be slower than if actually connected directly because the Master is 
interleaving the iTools access with its own. 

Note 
Currently, this will only access one Profibus or Modbus port below an instrument operating in Master mode. 

 

Note 
This graphic shows Modbus Serial, communicating via a Serial port. Profibus, communicates via a Profibus 

port, and Modbus-TCP communicates via a Ethernet port. 

 

What is Profibus ? 

Profibus is a communications protocol.  Instruments that communicate via this protocol allow the 
fast, cyclic, transfer of time critical data from intelligent devices such as temperature controllers, I/O 
units, drive, etc to a PLC or PC based controller, with a scan time of around 10mS. 
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Traditional PLC based control systems use a central processor unit fitted in a rack, connected to I/O 
modules via an internal PLC ‘backplane’.  Terminals on the I/O modules are connected to the real 
world using point to point cabling, ending at field terminal units.  The PLC scans the input modules 
cyclically and places the values from them into registers in the central processor, where they are 
operated on by ladder logic. Similarly, values from PLC registers are provided to output modules and 
applied to physical outputs. 

The simplicity of the wiring scheme makes for easier maintenance, and provides flexibility to add 
new devices when and where needed.  Furthermore, instead of being tied to the offerings of a single 
vendor, ‘best of breed’, specialised, devices may be used, reducing the processing load on the PLC. 
 With devices located close to their point of application, and closely coupled to it, they may be used 
to provide feedback on their operation, reducing the need for planned maintenance and allowing 
quality improvement using statistical process control techniques. 

Profibus DP provides fieldbus product offerings because it has proven to be very easy to apply and 
understand, even for non specialists. 

 

What is EI-Bisynch ? 

EI-Bisynch is a proprietary protocol based on the ANSI X3.28-2.5 A4 standard for message framing. 
 Despite its name, it is an ASCII based asynchronous protocol.  Data is transferred using 7 data bits, 
even parity, 1 stop bit. 

Address 

Each instrument has a configurable address consisting of two digits, the first being a ‘group’ number 
0 to 9, and the second a ‘unit' number 0 to 9.  There are, in principle, therefore 100 different 
addresses that may be used, 00 to 99, although in some instruments, address 00 is reserved for use 
in configuration mode, leaving addresses 01 to 99 available. 

Mnemonics 

EI-Bisynch identifies parameters within an instrument using what are known as ‘mnemonics’. These 
are usually two letter abbreviations for a given parameter, for example PV for Process Variable, OP 
for Output, SP for Setpoint, and so on. 

Channels 

EI-Bisynch provides for ‘channel’ data. This would be used, for example, when a single physical unit 
contains several independent control loops, each having their own Process Variable, Setpoint, and 
Output Power. In this case, the values for each loop are obtained by specifying different channel 
numbers: ‘1’, ‘2’, etc. 

The channel number, if used, is encoded as a single ASCII character preceding the mnemonic, for 
example 1PV. 

 

Network Specifics 

Networks began as a simple idea to link a few computers together in order to exchange messages 
and to share files and peripheral equipment, such as printers and modems.  These Local Area 
Networks (LANs) frequently consisted of one server and groups of independent workstations with 
similar operating systems and software, capable of operating with or without the network. Networks 
are now more complex and diverse, and have become an essential component of day-to-day 
business.  Most LANs commonly support many different types of operating systems and hardware 
platforms and are often linked together to form Wide Area Networks (WANs). 

The Project Organiser supports the creation of, 

 Local Instrument Network (LIN) 
 Modbus 
 Profibus 

 EI-Bisynch 
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The image below shows a very basic plant/system Network.  This could easily be expanded to 
include more Computers, connected via different Local Instrument Networks, LIN, communicating to 
even further Instruments that in turn communicate to other Instruments via a simple Instrument 
Network. 

 

 

Plant Model Specifics 

When creating the Plant Model, consider how the plant needs to operate and the 
association between equipment that performs a task, such as filling or venting a vessel 
rather than the Instruments and their location in the plant. 

Example 
A Boiler House (Process Cell) contains a Boiler (Plant Unit). 

A Boiler House distributes the steam, used on the rest of the plant by other 
Process Cells. The Boiler produces the steam ONLY in this location. 

One way to start thinking of the Plant Model is to review the P&IDs for the system and 
group the P&IDs into those that are closely related in producing a ‘sub-product’ within the 
plant. 

 The basis of the Process Cell is created by a closely related group the P&IDs, that 
together produce a ‘sub-product’ within the plant. 

 The major pieces of equipment (boilers, rectors etc.) in each P&ID then form the 
Plant Units. 

 The smaller pieces of equipment (valves, pumps etc.) then form Control Module 
Tags. 

 The general I/Os then form simple Tags in the Plant Unit. 
 

Control System Hardware Design 

The control system hardware design will usually follow the Plant Model. Generally Process 
Cells map to a cubicle (strategy engines and I/O) and a Plant Units map to a small 
strategy engine or an I/O rack within the cubicle.  Grouping the Plant Unit around an I/O 
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rack will usually match the cable entry from the field and make the design simple to 
understand. 

Tip! 
Aim to keep all the Tags of a Plant Unit within a single strategy engine, but not 

at all costs. 

 Larger strategy engines can handle more than one Plant Unit. 
 

Alarm Group Specifics 

When creating the Alarm Groups, be aware of any current Plant Units created in the Plant 
Model.  These will generally be major pieces of equipment (boilers, rectors etc.) that must, 
almost definitely, report alarms in the InTouch Supervisory Computer during run-time. 

It may be chosen to coincide with an existing Plant Unit as this is where an alarm is likely 
to occur, or it may combine a set of similar alarms, such as all ‘level alarms’ across the 
plant.  An Alarm Group could also contain any collection of Tags that will help the operator 
react when an alarm occurs. 

Any Tag may be assigned to several different Alarm Groups at the same time, if this is 
thought helpful and may also be assigned more than once to the same Alarm Group, 

 as an individual Tag, and 
 via any number of Plant Unit allocations. 

When an Instrument Block reaches an alarm state the Alarm Provider interrogates the 
appropriate Tag to identify which Alarm Group the alarm originated. 

Example 
A Boiler House (Process Cell and Alarm Group Set) contains a Boiler (Plant Unit and Alarm Group). 

A Boiler House distributes the steam, used on the rest of the plant by other Process Cells.  The 
Boiler produces the steam ONLY in this location, but if the Boiler steam pressure falls below the 

required level an alarm is raised. 

 

Alarm Group Sets Specifics 

When creating the Alarm Group Sets, be aware of any current Process Cells.  These will 
generally be a ‘sub product’ within the plant (boilers, rectors etc.) containing Plant Units 
(including Tags) that are included in Alarm Groups that must also report alarms to an 
InTouch Supervisory Computer during run-time. 

An Alarm Group Set may be chosen to coincide with an existing Process Cell to simplify 
the configuration as the Alarm Group Set contains Alarm Groups that must be displayed 
on a specific InTouch Supervisory Computer during run-time. 

Any Tag may be assigned to several different Alarm Groups Sets at the same time via any 
number of Alarm Group allocations, if this is thought helpful and may also be assigned 
more than once to the same Alarm Group, 

 as an individual Tag, and 
 via any number of Plant Unit allocations. 

When an Instrument Block reaches an alarm state the Alarm Provider interrogates the 
appropriate Tag to identify from which Alarm Group the alarm originated, and then the 
Alarm Group Set to distinguish which specific InTouch Supervisory Computer will display 
the alarm. 

Example 
A Boiler House (Process Cell and Alarm Group Set) contains a Boiler (Plant Unit and Alarm Group). 

A Boiler House distributes the steam, used on the rest of the plant by other Process Cells. The 
Boiler produces the steam ONLY in this location, but if the Boiler steam pressure falls below the 

required level an alarm is raised. The alarm originates from a Tag in the Boiler Alarm Group in the 
Boiler House Alarm Group Set which are displayed on the run-time Server ONLY. 
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Computer specifics 

A Computer represents a focal point for the display of selected groups of alarm(s), Alarm Group 
Set(s).  This simplifies the control and management of alarms, and the deployment of the Project 
and Security databases. 

Note 
Multiple Alarm Groups Sets can be allocated to any configured Computer. 

All Project client and server computers must be configured.  Each runs Factory Suite client 
applications and/or a LIN Data Server.  Each Computer can be configured to operate as a 
FactorySuite client running FactorySuite applications and/or a LIN Data Server.  Any Computer that 
runs LINData/LINOPC provides LINData to the rest of the system. 

Note 
By selecting the properties of a Computer, available parameters can be used to configure Computer and 

Server Settings. 

The Alarm Provider Mode indicates how the Alarm Provider should run on this server. 

 Disabled 
Alarm Provider will not provide any alarms. 

 No Standby 
Alarm Provider will provide alarms, but will not provide alarms if there is a backup alarm 
provider. 
 Standby 

Alarm Provider will provide alarms and will provide alarms of the server that it is backing up if 
that server fails.  However it will not pre-cache the function blocks. 
 Hot Standby 

Alarm Provider will provide alarms and will provide alarms of the server that it is backing up if 
that server fails.  It will pre-cache the function blocks. 

The Project and Security databases are deployed to the configured Computers so allow client 
computers to run the InTouch Application from the Development Server (DS).  To ensure successful 
deployment of the Project and Security databases and operation of the InTouch Application on client 
computers the following MUST be observed. 

 Each computer has a fully functional Ethernet network connection.  Windows sharing will not 
be active if the network is disconnected. 

 Each computer has a ‘Shared’ network path to the Project folder that will contain a replica 
Project database. 

 Any computer that will be used to operate the InTouch Application has DCOM correctly 
configured. 

 Any computer that will be used to operate the InTouch Application has appropriate 
compatible NT login User accounts stored locally. 

IMPORTANT NOTE 
Systems configured with more than 10 (ten) Windows NT workstations (including any office computers (or 

similar)) are supported by the Windows Server Operating System ONLY. 

 

Access Names 

Access Names allow the LINData application and the VIEW application to access the I/O Servers, 
the application on the server and the Security User Name. 

 

LINData application 

The LINData application is the Data Server for LIN I/O.  When using the LINData application the 
topic of the access name is derived from the <Client Computer Name>@<Access 
Name>@<Security User Name> at runtime. 
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Unsecured writes, writes without the .w fixed fields, to a LIN item requires LINData to extract the 
Security User Name from the Topic of the Access Name. 

Note 
This can be configured with a Standby Server Computer. 

 

VIEW application 

The VIEW application is the Data Server providing connectivity between the LIN control network and 
the plant enterprise network.  It provides a defined interface using Wonderware InTouch and allows 
data distribution across geographical and organizational boundaries. 

This application can be deployed across the network and the simple to implement distribution 
features eliminate the need to duplicate data within each node.  An additional Wonderware InTouch 
application can run in conjunction with VIEW application allowing operator displays, trending, 
alarming and user-centric security. 

It will automatically allow the servers to changeover if the Master Server watchdog fails, when two 
Computers are configured to operate as a redundant partners. 

 

What is the Alarm Provider ? 

The Alarm Provider is a process that runs on an InTouch Supervisory Computer (a server 
computer) that monitors the alarm fields of Blocks in the control instruments.  The Alarm 
Provider associates the alarms found with the configured Alarm Groups and distributes the 
alarm information to networked Alarm Clients configured Computer items. 

 

Displays Specifics 

The navigation between mimics on an Project is defined using Display Blocks.  The Properties of a 
Display provides all the features necessary for the creation and configuration of these Display 
Blocks. 

Note 
Each Display Block has properties to define the‘Alarm Page and Trend Page associated with the Block, and 

Navigational links to other Display Blocks. 

The Properties of a Display is divided into Display Block, and Display Navigation pages. 

Display Block Page 

A Display Block Page is a set of properties that define the mimic associated with the Display Block. 

Each Display Block is only associated with one plant mimic.  If the Display block is called by the 
SCADA system, this mimic file is displayed. 

Display Navigation Page 

The Display Navigation Page defines the navigation properties for a plant mimic. 

Each Display Block can link to any other Display Block, one per Navigation field, Up, Down, Next, 
and Previous. 

 

Trended Specifics 

Trend is an application that allows specified Tags from the Project database to be queried at defined 
time intervals, and plotted on a graphical display at a defined instrument or Computer.  When Tags 
are added to the InSQL (IndustrialSQL Server) or, InTouch (InTouch Server) Trended Tag container 
they can be control and manage the data in a Trend chart, and can be customised by configuring the 
display options and setting general options for use with all Trends. 
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Build Window 

 
Located in the lower part of the display area, this window displays validation errors. 

Registers or table data which fail the validation checks are displayed in Red. 

Validation is carried out 

 When a .upg file is loaded 
 When a .upg file is saved 

 Whenever data is modified 
Validation involves checking that the data is complete and that it is consistent with the LIN Database 
(.dbf) file - i.e. the referenced LIN fields exist in the .dbf file and are of the correct type. 

Tip! 
Double-click an error or warning record to access the application needed to correct the 

problem. 
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Project Item Contents 

What is the Project Organiser ? 

The Project Organiser is, depending on the selection, a list of ALL Tags, or just the I/O Tags, but not 
System Tags in the Project.  A default number of Tags are initially permitted for each Project Type, 
but this can be increased to the maximum number of Tags, OPC and InTouch Tags, supported by 
each Project Type as shown in the Project Properties.  The Licence Utility must be used to request 
an increase to the number of Tags permitted by the Project Type. 

It allows Tags to be moved or copied (assigned) to an item in the Tree View.  It also has full 
functionality for Attaching, Detaching, Deleting and Editing Tags using the relevant commands from 
the Tags menu. 

Tip! 
Assign Tags by dragging from the List View in either Project Organiser View or Tag Browser View 

and dropping them in the relevant item. 

Note 
When editing a Tag, write access is ONLY available to Users with sufficient Access Level User Rights, 

configured using the Security Manager. 

It also includes a Drop Target area, and New... context sensitive wizards functions, used to control 
and manage the items and Tags of the Project. 

 

What is the All Tags item ? 

The All Tags is a container and a set of Applications used to manage and control all the Tags within 
the Project.  Some Tag related Applications can be launched when it is selected.  New Tags can be 
created using the New Tags wizard available from the floating menu. 

Note 
Each Project Type allows a default maximum number of Tags.  Use the License Utility to increase the extents 

of the software, by specifying the purpose and number of function blocks, and therefore Tags, that can be 
used. 

The Applications available from the Application Toolbar allow the user to, 

 create a new Tag 

 reconcile differences between field values and live Instrument data 
 configure the Tag Block and Point Type 
 import and export Tags 
 configure multiple Tags 

 

What is the Networks item ? 

The Networks is a container for instrument networks and a set of Applications used to manage and 
control the communications Networks throughout a Project. 

Instrument networks usually map onto Computer ports, so it is often easier to create the actual port 
configurations first using the Configure LIN ports Tool (LINOPC applet in the computer control panel) 
that is available in the Application Toolbar when the Networks object is selected. 

Tip! 
It is good practice to, where possible, keep the network names and port names the same. 

The Applications available from the Application Toolbar allow the user to, 

 create a new Network 
 clone a Network 
 open Instrument Network explorer 
 configure LIN Ports 
 build this and all subsequent instruments and networks 
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Network 

A Network represents a single instrument network.  It contains instrument items that represent real 
instruments and can be directly communicated with on the network.  The property page allows the 
online port (LINOPC port) to be configured for the network, allowing the network to be used when 
monitoring instrument databases.  New networks can be created using the New Network wizard. 

The Tools available from the Application Toolbar allow the user to, 

 create a new Network 
 clone a Network 
 open the instrument Network explorer 
 build this and all subsequent instruments and networks 

Instrument 

An Instrument represents an instrument on the network.  The properties page allows some 
Instrument parameters, i.e. node address, to be modified so it corresponds to the real instrument. 
 The Application Toolbar allows the LINTools Engineering Studio to be launched.  This is used to 
configure or monitor to instrument. 

The Instrument can also contain a network folder, if the instrument has a further Instrument Network, 
such as Modbus.  An instrument may be added to the network using the New Instrument wizard. 

The Tools available from the Application Toolbar allow the user to, 

 create a new Instrument 

 clone an Instrument from a selected Network 
 configure, control and monitor a LIN Instrument control strategy 
 reconcile differences between field values and live Instrument data 
 build this and all subsequent Instruments and Networks 
 configure, control and manage live I/O Instrument hardware 
 control and manage the LIN Instrument control strategy files 
 control the live Instrument 

Instrument Network 

An Instrument Network represents a network from an instrument.  It contains instrument items 
representing real instruments that can be directly communicated with on the Instrument Network. 
 The property page allows the online port to be configured for the network that can be used when 
monitoring instrument databases, as well as the selection of the I/O port on the instrument (for those 
that support multiple ports).  A new Instrument Network, usually for Modbus, Profibus or EI-Bisynch, 
can be created using the New Network wizard available from the floating menu. 

The Tools available from the Application Toolbar allow the user to, 

 create a new Network 
 clone a Network 
 build this and all subsequent Instruments and Networks 

I/O Instrument 

An I/O Instrument represents an instrument that is communicated to directly from another 
instrument.  An I/O instrument is used to provide inputs and outputs for the use of the control 
strategy within the master instrument.  The primary tool is usually iTools Engineering Studio which 
can be used to configure the instrument database, but 'Live' values from a defined I/O Instrument 
can be displayed using iTools OPC Scope.  An I/O instrument may be added to the network using 
the New Instrument wizard available from the floating menu. 

The Tools available from the Application Toolbar allow the user to, 

 create a new Instrument 
 configure, control and monitor an I/O Instrument control strategy 

 clone an Instrument from a selected Network 
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 configure, control and manage live I/O Instrument hardware 
 

What is the Plant Model item ? 

The Plant Model is a container for Process Cells, and any subsequent Plant Units.  The 
Plant Model is used to manage the physical layout of the plan and defines a function of 
each Tag in the plant. 
Configuring the Plant Model can be useful, as a Plant Unit item in any Process Cells can 
be used within Alarm Groups and Security Areas, instead of single Tags. 

Note 
A Plant Model can help in understanding how each part of the plant interacts, and 

therefore how best to structure the software that controls it.  This assists in simplifying 
the control system design, and run-time Tag browsing. 

The Applications available from the Application Toolbar allow the user to, 

 control and manage Plant Unit using Process Cells 

 control and manage Tags using Plant Units 

 produce a hard copy report of the Tag Security Area configuration 

Process Cell 

The Process Cell represents a sub-division of the plant that is generally a part of the final 
product.  The property page allows a name and description to be entered.  Any number of 
Process Cells can be created using New Process Cell wizard. 

 create a new Process Cell for managing Plant Units 

Plant Unit 

The Plant Unit represents a particular unit of the plant and should contain all the Tags that 
are part of that unit.  The property page allows a name and description to be entered. 
 Tags can be assigned to the Plant Unit from any source within Project Organiser using 
copy and paste, or drag and drop.  Plant units can be created using New Plant Unit 
wizard. 

 create a new Plant Unit for managing the Tags that appear in Unallocated 

Unallocated 

The Unallocated operates as a useful filter for Tags that have not been assigned in this 
item.  Tags can be assigned to any destination within Project Organiser using copy and 
paste, or drag and drop. 

Note 
This Process Cell (Unallocated) already exists and will contain ALL unassigned Tags. 

 The Process Cell, Unallocated, allows Engineer level security access to Tags NOT 
assigned to a Plant Unit. 

 

What is the Alarm Groups item ? 

The Alarm Groups is a container for Alarm Groups.  The Alarm Groups are used to control 
and manage the Tags monitored for alarm purposes and displayed on an InTouch 
Supervisory Computer. 

Note 
A maximum of 255 Alarms Groups are allowed. 

Empty Projects automatically contain the Alarm Group, Default.  This group is the initial 
destination for all new Tags.  To simplify the configuration of Alarm Groups, the name can 
be changed and/or a different Alarm Group can be defined as the Default.  If the Default 
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container does not exist any new Tag will not be automatically assigned and MUST be 
assigned using copy and paste, or drag and drop. 

Tip! 
Alarm Groups are used to clarify the location of an alarm. 

The Applications available from the Application Toolbar allow the user to, 

 control and manage Tags used to report Alarms 
 produce a hard copy report of the Alarm Group configuration 

Alarm Group 

Each Alarm Group contains Plant Units and Tags.  All the Tags in the Alarm Group, or 
Tags within Plant Units that are in the Alarm Group, will be alarmed and associated with 
that Alarm Group at run-time.  The property page allows the name and description to be 
changed as well as allowing a selected Alarm Group to be set as the default.  The default 
Alarm Group is the initial destination for all new Tags and will, by default, automatically 
report alarms on the run-time system.  Tags or Plant Units can be assigned to any Alarm 
Group within Project Organiser using copy and paste, or drag and drop.  Alarm Groups 
can be created using New Alarm Groups wizard. 

Note 
Alarm Groups can be assigned to Alarm Group Sets to assist with the configuration of 

the Computer Alarm View container. 

 create a new Alarm Group for managing the Tags that appear in Unallocated 

Unallocated 

The Unallocated operates as a useful filter for Tags that have not been assigned in this 
item.  Tags can be assigned to any destination within Project Organiser using copy and 
paste, or drag and drop. 

Note 
This Alarm Group (Unallocated) already exists and will contain ALL unassigned Tags. 

 The Alarm Group, Unallocated, allows Engineer level security access to Tags NOT 
assigned to an Alarm Group. 

 

What is the Alarm Group Sets ? 

The Alarm Group Sets is a container for a user-defined set of Alarm Groups.  The Alarm 
Group Sets are used, in conjunction with Computer Alarm Views container, to control and 
manage the sets of Alarm Groups displayed on a specific InTouch Supervisory Computer. 

Tip! 
Alarm Group Sets are only used to ensure that client computer (Operations 

Viewer) can view only the required sets of Alarm Groups. 
The Applications available from the Application Toolbar allow the user to, 

 control and manage Alarm Groups containing Tags used to report Alarms 

 produce a hard copy report of the Alarm Group Sets configuration 

Alarm Group Set 

Each Alarm Group Set contains a set of Alarm Groups.  The property page allows a name 
and description to be entered.  Alarm groups can be assigned to any Alarm Group Set 
within Project Organiser using copy and paste, or drag and drop.  Alarm Group Sets can 
be created using New Alarm Group Set wizard. 

Note 
When an Alarm Group is assigned to an Alarm Group Set, all subsequent Plant Units 

and Tags are automatically included. 
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 create a new Alarm Group Set for managing the Alarm Groups 
 

What is the Tag Security item ? 

The Tag Security item is a container for Tag Security Areas and a set of Tools used to manage and 
control the Tag Security Areas. 

IMPORTANT NOTE 
Tags can be assigned to a single Tag Security Area ONLY. 

Tag Security Areas are configured to allow specific Tags to be edited by Users with a sufficient level 
of access only.  Any User in any User Group can be allowed access to all the Tags that are 
unassigned by selecting the Tag Security Area, Unallocated, from Security Manager. 

The Tools available from the Application Toolbar allow the user to, 

 create a new Tag Security Area used to define a level of access 
 configure user access to Instruments and Tags 
 configure the Tag Block and Point Type 
 produce a hard copy report of the Tag Security Area configuration 

Tag Security Area 

The Tag Security Area contains Plant Units and Tags.  All the Tags in the Tag Security Area, or 
Tags within Plant Units that are in the Tag Security Area, can be given a level of access.  The level 
of access limits the access of each group of Tags to specific groups of users with equivalent level of 
security configured using Security Manager.  The property page allows the name and description to 
be changed, but if the Tag Security Area is renamed it must also be changed in Security Manager. 
 Tags or Plant Units can be allocated to any Tag Security Area within Project Organiser using copy 
and paste, or drag and drop.  Tag Security Areas can be created using New Tag Security Area 
wizard. 

The Tool available from the Application Toolbar allow the user to, 

 configure user access to Instruments and Tags 
 configure the Tag Block and Point Type 

Unallocated 

The Unallocated operates as a useful filter for Tags that have not been assigned in this item.  Tags 
can be assigned to any destination within Project Organiser using copy and paste, or drag and drop. 

Note 
This Tag Security Area (Unallocated) already exists and will contain ALL unassigned Tags.  The Tag Security 

Area, Unallocated, allows Engineer level security access to Tags NOT assigned to a Tag Security Area. 

 

What is the Computers item ? 

The Computers is a container for any Computer on a Network in a system and a set of Tools used to 
control and manage a replica of the actual LIN connections used.  By creating a Computer in Project 
Organiser, it is automatically included in the list of Computers that can receive updated Project 
and/or Security databases when deployed. 

It is important to the functioning of Operations Viewer and, effectively, defines the system's computer 
network architecture. 

Note 
Computers must be configured to run Operations Viewer within the system. 

The Tools available from the Application Toolbar allow the user to, 

 create a new Computer 

Computer 

The Computer contains Ports, if the Computer is configured as a Server Computer only, and Alarm 
Views.  The property page has Computer (or client) and Server property parameters.  It applies to 
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both client and server (a server is also a client) computers.  Each Computer can operate as either a 
Client or a Server.  When a Computer is configured as a server, it can be paired with another server 
for operating as a redundant pair.  Computers can be created using New Computer wizard. 

IMPORTANT NOTE 
Always configure the ports to communicate with the instrumentation from a Server Computer. 

The Tools available from the Application Toolbar allow the user to, 

 create a new Computer for managing Port and Alarm Views 

Ports 

The Ports contains Network Ports in the system.  Ports can be created using New Port wizard. 

IMPORTANT NOTE 
When Computers are configured to operate as a redundant pair, the Ports and Network configuration of both 

Computers in the redundant pair must be identical. 

 create a New Port used to identify a connection to a Network 
 configure LIN Ports 

Port 

The Port represents an actual LINOPC port on a Server Computer, as shown in the Networks 
container.  The Port name MUST be identical to the name of the Port, as configured on the 
Computer using the Configure LIN ports Tool (LINOPC applet in the Computer control panel).  The 
property page allows the Port name to be defined and the Network name to be associated with the 
Port.  The Network name MUST correspond with the Server Port, LINOPC Port Name, as shown in 
the Properties dialog from the Computer Network item. 

IMPORTANT NOTE 
Network communication between Computers and instruments will fail if the Port on the server computer is 

not correctly configured. 

Note 
All existing instruments and subsequent instrument networks are also displayed in this container. 

Alarm Views 

The Alarm Views contains Alarm Group Sets.  If Alarm Group Sets are not allocated to the Alarm 
Views all alarms will be visible.  Alarm Group Sets can be allocated to Alarm Views using copy and 
paste, or drag and drop. 

Tip! 
Alarm Group Sets are only used to ensure that client computer (Operations Viewer) can view only 

the required sets of Alarm Groups. 

What is the Displays item ? 

The Displays is a container for screens created to display appropriate parts of a plant.  The Displays 
is used to control and manage the navigation scheme to be defined for mimics within the Operations 
Viewer.  There are buttons within the Operations Viewer that allow the operator to navigate between 
the custom displays, if the displays have been correctly defined and linked. 

Note 
Generally, there is only one InTouch Application per system. 

The Tools available from the Application Toolbar allow the user to, 

 create a new Display Block, used to configure links between mimics 

 create displays using WindowMaker to show data from specific parts of a system 
 configure, control and manage the navigation scheme defined for mimics within the 

Operations Viewer 

Display 

The Display represents a mimic display within the Operations Viewer using WindowViewer.  The 
application used to create a display is WindowMaker.  This is the primary InTouch Application, it is 
normal to only have one, but during runtime the displays are shown using WindowViewer.  The 
property page allows extra attributes to be associated with the mimic, such as security and related 
pages, and can be used to define the navigation between each of the displays. 
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The Tools available from the Application Toolbar allow the user to, 

 create displays using WindowMaker to show data from specific parts of a system 
 configure, control and manage the navigation scheme defined for mimics within the 

Operations Viewer 
 configure user access to Displays 

Note 
If the project was created as a Managed Application (Plant Solution with Operations - ArchestrA, or 

Modbus I/O with Operations - ArchestrA), then the project must be edited through the Archestra IDE.  
Within the ArchestrA IDE, use the FoxboroPAC > Configure EurothermSuite Apps menu option (or click 

the Manage EurothermSuite Applications toolbar icon) and then click the Edit button. 

 

What is the Trended item ? 

The Trended item is a container for different trend items that contain Tags.  The Trended is used to 
control and manage the Tags that are used to define values that are to be recorded and displayed at 
runtime in the defined Application. 

There are no Tools available from the Application Toolbar, and there is no Property dialog. 

Note 
It is used simply to assign Tags to a method for recording values changes in a system. 

InSQL Trended Tags 

The InSQL Trended Tags is a container for Tags that are to be recorded within InSQL.  Any Tags 
can be allocated, but only Tags specifically used for trend purposes will operate correctly.  Tags can 
be assigned from any source item within Project Organiser using copy and paste, or drag and drop. 

Note 
When theTags are allocated, a build operation from the Project folder will create files that may be imported 

into InSQL to configure it. 

InTouch Trended Tags 

The InTouch Trended Tags is a container for Tags that are to be recorded within the InTouch 
Application.  Any Tags can be allocated, but only Tags specifically used for trend purposes will 
operate correctly.  Tags can be assigned from any source item within Project Organiser using copy 
and paste, or drag and drop. 

Note 
When the Tags are allocated, a build operation from the Project folder will configure the Tags to be trended 

within the InTouch application. 

Non-Trended Tags 

The Non-Trended Tags operates as a useful filter for Tags that have not been assigned in this item. 
 Tags can be assigned to any destination within Project Organiser using copy and paste, or drag and 
drop. 

 

What is Store and Forward ?  

The Store and Forward tool is used to configure a means of replacing periods of lost data in  InSQL 
and the Alarm database using data from the .uhh files in LIN instruments and 5000/6000 recorders.  

Runtime data is recorded in  

 InSQL - used for process values. 
 Wonderware Alarm database - used for alarm and events 
 AlarmSuite - used for alarm and events 

Any periods of lost data in the databases can be filled by extracting data stored locally on the 
instruments in .uhh files, and writing it to the databases. 

Note 
The Store and Forward User Guide can be opened from the Online Books Index page. 
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4. Menu Overview 

The Menu can be divided into the following command and information areas, 

 Menu Bar 

 
 ToolBar 

 

 Application ToolBar 

 

 Wonderware Build ToolBar 

 

 Deploy ToolBar 

 
 Status Bar 

 

 

Menu Bar 

The Menu Bar is a special toolbar at the top of the screen that contains the pulldown 
commands.  Each pulldown displays a list of commands. 

 
File 

The File pulldown enables the User to launch a selected operation for a Project. 
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Note 
This menu changes as each item is selected, i.e. when a Network is selected the 'New 

Instrument' wizard can be launched. 

New Project 

When selected this command initiates the New Project wizard. 

Follow the instructions to create a new Project. 

Exit 

When selected this command terminates the Project Organiser, but does not affect 
Windows Explorer instance. 

 

Edit 

The Edit pulldown enables the User to launch a selected operation for managing the 
current objects and Tags of the selected container. 

 
Find 

When selected this command displays a dialog allowing the User to search for specific 
sequence of characters.  When located they can be sorted in alphabetical ascending or 
descending order. 

Note 
Double clicking an object reveals the contents of the object in the Editor Contents 

Region. 
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View 

The View pulldown enables the User to launch the selected operation to change the 
emphasis of the currently selected Project. 

 
All Tags view 

When selected this command displays ALL the Tags contained in the selected container in the order 
defined by selecting the appropriate column. 

I/O Tags Only view 

When selected this command displays the I/O Tags only contained in the selected container in the 
order defined by selecting the appropriate column. 

Project Organiser View 

This view includes the additional functions, such as the Drop Target, and New... context sensitive 
wizards. 

Tag Browser View 

The Tag Browser View is a simple view of the Tags included in the selected item, and also any Tags 
associated with a specific part of the System. 

Note 
The list of Tags can be filtered into either, All Tags used in the Project, oronly  I/O Tags using the relevant 
View command.  However, the System Tags will not be displayed if View > I/O Tags Only or View > Project 

Organiser View is selected. 

The Tag Browser is, depending on the selection, a list of ALL, including System Tags, or just the I/O 
Tags in the Project.  This allows Tags to be selected so that they can be moved or copied (assigned) 
into a container for use by the container Application, i.e. Plant Unit, or Tag Security Area ,etc., in the 
Tree View. 

Tip! 
Assign Tags by dragging from the Tag Browser and dropping them in the relevant container.  It 

also has full functionality for Attaching, Detaching, Deleting and Editing Tags using the relevant 
commands. 

System Tags 

The System Tags, as shown in the Tree View, is a list of Tags used by other applications in the 
system.  When the Tag Browser View is selected the Tags in the Project are displayed in the List 
View. 

Note 
The list of Tags can be filtered into either, All Tags used in the Project, or I/O Tags only using the relevant 
View command.  However, the System Tags will not be displayed if View > I/O Tags Only or View > Project 

Organiser View is selected. 
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Edit Tag Dialog 

When this dialog is open, fields within the function block can be edited.  Although write access is 
ONLY available to Users with sufficient Access Level User Rights, configured using the Security 
Manager. 
 

What is the Tag Browser ? 

The Tag Browser is, depending on the selection, a list of ALL Tags, including System 
Tags, or just the I/O Tags in the Project.  This allows Tags to be moved or copied 
(assigned) to an item in the Tree View.  It also has full functionality for Attaching, 
Detaching, Deleting and Editing Tags using the relevant commands from the Tags menu. 

Tip! 
Assign Tags by dragging from the List View in either Project Organiser or Tag 

Browser View and dropping them in the relevant item. 

Note 
When editing a Tag, write access is ONLY available to Users with sufficient Access 

Level User Rights, configured using the Security Manager. 

Details View 

When selected this command displays the contents of the selected Tool in a more detailed view. 
This will show the Tags, including additional information such as Tag Type, Reference and 
Description, used by the selected Tool in the main display. 

Note 
If the Project Folder is highlighted, and View > All Tags is specified, all the Tags in the Project are shown 

with the additional information. 

List View 

When selected this command displays the contents of the selected item in a simple list 
format in the order defined by selecting the appropriate column. 

Note 
List View is also referred to as Report View in the Tag Browser. 

Refresh 

When selected this command updates the contents of the window and displays appropriate icons 
representing the currently requested information. 

 

Tools 

The Tools pulldown enables the User to launch a selected application for configuring parameters 
that exceed the limits of Project Organiser. 
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LINTools Engineering Studio 

When selected this command launches LINTools Engineering Studio, the Application used to 
configure, control and inspect the explicit Control strategy of a LIN Instrument in a Project/system. 

iTools Engineering Studio 

When selected this command launches iTools Engineering Studio, the Application used to configure, 
control and inspect the explicit Control strategy of an I/O Instrument in a Project/system. 

I/O Manager 

When selected this command launches I/O Manager Utility, the Application used to control, manage, 
inspect and identify explicit Control strategy of an I/O Instrument in a Project/system 

Security Manager 

When selected this command launches Security Manager, the Application used to configure to 
security of a Project/system. 

Display Navigation 

When selected this command launches Display Navigation Configurator, the Application used to 
configure and inspect explicit Display Blosks, and the navigation scheme within the Operations 
Viewer, of a Project/system. 

WindowMaker 

When selected this command launches the Wonderware Window Maker, the Application used to 
configure, manage, inspect and identify explicit Windows used in this Project/system. 

Project Configuration 

When selected this command launches Project Configuration Utility, the Application used to 
configure, inspect and identify explicit information relating to the Computer system in a 
Project/system. 

Note 
Generally, this Utility will only be used to configure Plant Solutions Projects, but will also allow changes to 

the Project Identification Properties, and define the Active Project. 

What is an Active Project? 

An Active Project is used to identify that the current Project will allow data access from any OPC 
client, including third party clients, to the LIN Devices in the Project. 

When set as the Active Project, the LINOPC server will provide 

 browsing of Tags in the Active Project 
 a shorter syntax for accessing the data in the OPC Tags 

License Utility 

When selected this command launches License Utility, the Application used to inspect and identify 
the type of use offered by the software for configuring a Project/sytem. 

System Checking Tool 

When selected this command launches System Checking Tool, the Application used to validate an 
installation and configure selected default parameters used in a Project. 

LINOPC Control Panel 

When selected this command launches LINOPC Control Panel, the Application used to inspect and 
identify explicit Network Ports of a Project/system. 
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Tags 

The Tags pulldown enables the User to launch the selected operation to control the association 
between Tags and real-time values. 

 

New Tag 

When selected this command initiates the New Unattached Tag wizard, and on completion will 
generate an unattached Tag that can be attached using the Attach Tag command. 

Follow the instructions to create a new Unattached Tag. 

Attach Tag 

When selected this command allows the selected Tag(s) to be attached to the Field or Subfield of a 
Block. 

Note 
If a Tag is attached, it may then be detached, deleted, or edited. 

Detach Tag 

When selected this command allows the currently attached Tag(s) to be detached from the Field or 
Subfield of a Block.  This allows it to be transferred to a different location and attached to a field, 
subfield or an Auto created Block, without resulting in the lose of any Tag configuration. 

Note 
If a Tag is detached, it may then be attached, deleted, or edited. 

Delete Tag 

When selected this command the currently selected Tag will be deleted from the system.  The 
deleted Tag(s) are stored in a folder only visible in an Explorer window, revealed by selecting 
Project > Explore. 

Note 
Deleted Tag(s) are not permanently removed from the system until the folder storing the deleted objects is 

deleted from the Explorer window. 

Tag Profile Configurator 

When selected this command launches Tag Profile Configurator, the Application used to configure, 
and inspect the explicit Block Type and Point Type of Tags used in a Project/system. 

Parameter Reconcile 

When selected this command launches Parameter Reconcile, the Application used to inspect and 
identify explicit field values of a Project/system. 

Mass Edit 

When selected this command launches Mass Edit Utility, the Application used to configure explicit 
changes to many Tags simultaneously in a Project/system. 
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Tag Import/Export 

When selected this command launches Tag Import/Export Utility, the Application used to manipulate 
a set of Tags to and from a Project/system. 

Note 
Tags that exist in the Project can be exported to an appropriate text editor, .csv/.txt file, whereas a list of 

Tags currently existing as a .csv/.txt file can be imported in to a Project/system. 

 

Project 

The Project pulldown enables the User to launch the selected operation to manage the Project. 

 

Explore Project 

When selected this command launches Windows Explorer, the Application used to inspect and 
access explicit files of a Project/sytem. 

Full Project Build 

When selected this command launches a Build operation, the Application used to update the Project 
database. 

All information included in the Project database is then accessible to the configured Applications and 
existing Tools. 

Tamperproof Alarms 

When selected this command launches Tamperproof Alarms History Configuration wizard, used to 
control and manage the tamperproof files, used in the Project/system by Review to ensure that all 
changes are recorded for Auditing purposes. 

Project Properties 

When selected this command launches Project Properties dialog, used to inspect and identify 
explicit information of a Project/system. 
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Online 

The Online pulldown enables the User to launch the selected operation to manage the Project. 

 

Explore Networks 

When selected this command launches the manufacturers explorer window, the Application used to 
inspect, control and manage all Real-Time Networks and Instruments in a Project/system. 

OPC Scope 

When selected this command launches iTools OPC Scope, the Application used to inspect, control 
and manage 'Live' data from a defined I/O Instrument in a Project/system. 

Bridge 

When selected this command launches the Bridge Configuration session, the Application used to 
identify a specific instrument, for inspecting the 'Live' data and historical logged data in a 
Project/system. 

 

Startup 

When selected this command launches the Operations Viewer display, the Application used to 
inspect, control and manage all Real-Time Project/system via a Computer. 

Shutdown 

When selected this command halts and closes the Operations Viewer display, the Application used 
to inspect, control and manage the Real-Time Project/system via a Computer. 
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Help 

The Help pulldown menu is divided into, 

 

 Documentation (including Contents, Index and Search) 
Opens the online help documentation with the selected as the priority command. 

Tip! 
The online help (this document) is also opened when F1 is pressed. 

 Online Books 
This command opens a list of documentation installed as part of the CD installation. 

Note 
This and additional information is available via the internet. 

 About Project Organiser 
The About command displays the program details including the name, version number, 
and description. 

ToolBar 

The ToolBar hosts icon buttons that enable quick access to limited Edit and View 
commands.  It is displayed by default at the top of the screen. 

Tip! 
Cut, Copy, Paste and Delete button commands are only available if specific 

conditions are correct. 

 
Small Icon 

When selected this command displays the contents of the selected object in a small size icon format. 
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Application Toolbar 

This ToolBar hosts icon buttons that enable quick access to the Tools used for configuring the 
selected containers and the parameters. 

Tip! 
Cut, Copy, Paste and Delete button commands are only available if specific conditions are correct. 

 

Application ToolBars 

Each button launches the corresponding Application. 

 

Note 
A specific set of Tools are available to configure each object. 

use Alarm Group Set wizard 

 

The Alarm Group Set, provides a central environment to create a container for a collection of Alarm 
Groups that include assigned Plant Units and Tags.  This simplifies the ability to identify the Tags 
used to report an alarm state to a specific InTouch Supervisory Computer in the Project/system. 

The Alarm Group Set contains all the Alarm Groups that are to be displayed in the Alarm banner of 
the specific InTouch Supervisory Computer, describing the location and other specified data about 
the Tag that initiated the alarm. 

Note 
Drag and drop Alarm Group Sets to the Alarm Views of the Computer to indicate which Alarms will appear. 

use Alarm Group wizard 

 

The Alarm Group, provides a central environment to create a container for a collection of Tags that 
are required to report an alarm state to the Alarm Provider.  The Alarm Group name is displayed in 
the Alarm banner in the InTouch Supervisory Computer, and can be used to describe the location 
and other specified data about the Tag that instigated the alarm.  This simplifies the ability to identify 
the Tags used to report an alarm state to a specific InTouch Supervisory Computer in the 
Project/system. 

Note 
Drag and drop Plant Units to the Alarm Group to simplify the Tag configuration will appear. 

use Build 

 

The Build, provides a central environment for listing any error or warning while ensuring the Project 
database remains up to date.  This simplifies the ability of manage and control the complete 
Computer based Project by allowing, 

 confirmation that the various levels of the Project are correct 
 the cause of any error or warning to be indicated 

It is launched by pressing the Build button in the Application Toolbar. 
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use Clone Network 

 

The Clone Network, provides a central environment for replicating an existing live Network, and 
specific instruments and all applicable files.  This simplifies the ability of reproducing the system by 
initiating a wizard that provides a list of existing live Networks.  A selected Network defined by the 
Port name, and defined instrument files, can be uploaded from the live Network, and Instrument. 

It is launched by pressing the Clone Network button in the Application Toolbar, available if the 
Network is selected. 

 

 

use Computer wizard 

 

The Computer, provides a central environment to create a reference to a Computer .  This simplifies 
the ability to create a new reference a Computer used in the Project/system and identify it as a 
Server or a Client. 

What is a Server Computer? 

The Server Computers are used to configure Operations Viewer server settings like LIN Ports or 
Access Names. 

What is a Client Computer? 

The Client Computers only allow the configuration of Alarm Group Sets viewed on the client 
machine. 

use Display Block wizard 

 

The Display Block, provides a central environment to create a new Display Block.  This simplifies the 
ability to create a new page related to a specific mimic that links to other mimics used in the 
Operations Viewer. 
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use Display Navigation 

 

The Display Navigation, provides a central environment to view and change the routing of displays, 
with regards to a specific display.  This simplifies the ability the control and manage all Displays 
shown on the Real-Time Computers, currently installed by allowing, 

 the inspection of the Display Blocks 
 the configuration of individual Display Blocks 

Note 
Can also be configured via the Display Block properties. 

 the configuration of the Display Blocks on a specific Computer 
It is launched by pressing the Display Navigation button in the large Toolbar, available if the Displays 
is selected. 

use Download to Instrument 

 

The Explore Networks, provides a central environment to communicate directly with a specific 'Live' 
instrument in the plant/system.  This simplifies the ability the control and manage Strategy files that 
exist on the Instrument in the plant/system by allowing, 

 the download of existing Application files held in the Instrument Folder from the Project 
Organiser. 

use I/O Manager 

 

The I/O Manager, provides a central environment for configuring the I/O subsystem.  This simplifies 
the ability to manage and control each module in a existing I/O subsystem by allowing, 

 configuration of the Module type, Termination type, and function blocks used to communicate 
with the tagged modules/channels, 

 allocation of Tags to Channels of the Modules 
 validation and reconciliation of the I/O subsystem 

It is launched by pressing the I/O Manager button in the large Toolbar, available if the Project Editor 
is selected. 

use Instrument wizard 

 (LIN) and  (I/O) 

The New Instrument wizard, provides a central environment to create both LIN and I/O Instrument 
Folders, as shown in the Network Folder.  This simplifies the ability to create an Instrument Folder 
file system, primarily used to store the Strategy files relating to this Instrument, but not exclusively. 

Follow the wizard instructions to create a new Instrument Folder. 

use LINOPC Control Panel 

The LINOPC Control Panel, provides a central environment to configure and manage each LIN Port 
of the Networks in the Project.  This simplifies the ability to control and manage the LIN Port 
connections, according to the live LIN connections that are fitted, by allowing, 

 the inspection of the LIN Ports from either a Network or Device perspective 
 the generation of LIN Ports 
 the editing of LIN Ports, including the Protocol name, LIN Node Address and IP Address, etc. 
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Tip! 
Any LIN Ports configured prior to creating a Project, are automatically appear in the Project 

Organiser when the Project is created.  If manually creating Networks use the same names for the 
Port and instrument Network names. 

It can also be launched by pressing the LINOPC Control Panel button in the Application Toolbar, 
available if the Network is selected. 

use LINtools Engineering Studio 

 

The LINtools Engineering Studio, provides a central environment to configure an instrument control 
strategy.  This simplifies the ability the manage and control an instrument control strategy either 
offline or online by allowing, 

 the inspection of the Instrument 
 the manipulation of an Instrument control strategy, using Databases, Sequences and Actions 
 the transfer of these configuration files for use in other Instruments 
 the download and control of control strategy files for use by the Real-Time Instrument 

Note 
Existing Real-Time Instrument control strategies can be saved to a Computer to allow offline configuration. 

It is launched by pressing the LINtools Engineering Studio button in the Application Toolbar, 
available if the Instrument from a Network is selected. 

use License Utility 

The License Utility, provides a central environment to control and manage a license after the User 
requirements have been defined, and the request for an appropriate license has been agreed by the 
manufacturer.  This defines the type of use offered by the software. 

It provides the ability to control and manage a specified maximum number of View (InTouch 
Application) and OPC blocks used in a Project configuration by allowing, 

 the generation of a new or temporary license 
 the update or restore of a current license 
 the inspection of the extents of the license 
 the identification of the Project database 

use Mass edit 

 

The Mass Edit, provides a central environment for performing specific changes to many Tags 
simultaneously.  This simplifies the ability to manage and control access to function block Fields and 
Alarms for performing changes to many LIN Block Tags at the same time. 

It is launched by pressing the Mass Edit button in the large Toolbar, available if the All Tags Editor is 
selected. 

use Network Explorer 

 

The Explore Networks, provides a central environment to view ALL networks and the connected 
instruments.  This simplifies the ability the control and manage all Real-Time Networks and the 
instruments, including computers, currently installed by allowing, 

 the inspection of the Network, node, and file properties 
 the transfer of configuration files between instruments 
 the download and control of database files from the desktop 
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It is launched by pressing the Explore Networks button in the large Toolbar, available if the Network 
Editor is selected. 

use Network wizard 

 (LIN) and  (I/O) 

The New Network wizard, provides a central environment to create both LIN and I/O Network 
Folders.  This simplifies the ability to create a Network Folder file system, primarily used to store 
selected Instrument information, each identified by an Instrument Folder, that are communicating via 
this Network.  Each Network Folder contains the knowledge of the Port, and Remote Computer 
name if configured, through which each Instrument can be accessed from the Project workspace. 

Follow the wizard instructions to create a new Instrument Folder. 

use Parameter Reconcile 

 

The Parameter Reconcile, provides a central environment to view and change values.  This 
simplifies the ability to control and manage both Mapped Offline and Online field value differences, 
and, LIN and/or I/O changed parameters. 

It provides the ability to control and manage explicit field values by allowing, 

 the update of all (or some) data locations 

 the change to a single value 
 the required values to be retained 

It is launched by pressing the Parameter Reconcile button in the Application Toolbar, available if the 
All Tags or an Instrument from the Network is selected. 

use Plant Unit wizard 

 

The Plant Unit, provides a central environment to create a subdivision of the Process Cell.  This 
simplifies the ability to create a container for information, generally about a major processing activity 
within the Process Cell, and typically centered on a major piece of processing equipment in the 
Project/system. 

use Port wizard 

 

The New Port wizard, provides a central environment to create a LINOPC Server Port on a 
Computer configured to operate as a Server.  This simplifies the ability to create a LINOPC port, 
primarily used to resolve Tags into physical addresses of the fields/blocks within a LIN Instrument 
Strategy. 

Note 
This wizard can only create a Server Port to represent each LINOPC port connected to a Server Computer 

configured via the Computer Properties dialog. 

Follow the wizard instructions to create a new Instrument Folder. 

use Print facility 

 

The Print facility, provides a central environment to produce specific Report type for a defined Print 
range.  This simplifies the ability the produce a report of a currently configured part of the system, by 
allowing, 
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 the Report type, i.e. Alarm group, Plant model, Tag security, to be defined 
 the Print range, i.e. single Alarm group, or All Alarm groups, to be defined 

It is launched by pressing the Print button in the large Toolbar, available if the Plant Model, Alarm 
group, Alarm group sets, or Tag security is selected. 

use Process Cell wizard 

 

The Process Cell, provides a central environment to create a subdivision of the plant..  This 
simplifies the ability to create a representation of an essential part of the final product in the 
Project/system. 

use Project Configuration 

 

The Project Configuration, provides a central environment to configure the parameters used by the 
WindowViewer (InTouch Application).  This simplifies the ability to configure, inspect and identify 
explicit information relating to the Computer system in a Project/system, 

It provides the ability to open a single instance of the Project Configuration Utility, and allows 

 the configuration of all the relevant parameters used by the Operations Viewer. 

use Project Properties 

The Project Properties, provides a central environment to configure the overall Project parameters 
required for consistent operation when configuring the Project.  This simplifies the configuration that 
defines the location of the Master Project and Security Databases in the configured Project used by 
LINOPC and Project applications by allowing, 

 the inspection of the Project information, such as customer details 

 the identification of the Master Computer, Project and UNC path 

use Security Manager 

 

The Security Manager Tool, provides a central environment to configure user accounts and carry out 
regular account management.  This simplifies the ability to manage and control all security features 
across a security configuration.  It provides update functionality to user accounts, logins, password 
changes, etc., and has the ability to distribute the security database to any Security item nodes, 
including itself, in the security configuration.  This Utility includes security features such as secure 
electronic signatures, and ‘Audit Trail’ trace-ability. 

Note 
The Security Manager Tool separates the system security configuration in to various security parameter 

categories.  Each security parameter category is defined on a tab. 

It is launched by pressing the Security Manager button in the Application Toolbar, available if Tag 
Security is selected. 

What is the Security Manager Tool ? 

Security Manager is a central environment used to configure levels of security for User Groups 
(including designated Users) and Tag Security Areas. 

The Security Manager allocates Tag Security Areas to a User Group and allows each Tag Security 
Area to be configured with appropriate Access Level User Rights.  Each User Group can also be 
configured with a level of confirmation that will be required if amending selected information before 
the changes to the Tag can take effect. 
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use Shutdown 

 

The Shutdown, provides the ability to terminate the WindowViewer (InTouch Application). 

It provides the ability to end the single instance of the WindowViewer (InTouch Application), by 
allowing 

 the shutdown of all the relevant Applications used by the Operations Viewer. 

use Start/Stop Instrument 

 (Start Instrument) and  (Stop Instrument) 

The Control Instrument, provides a central environment to control the basic operation of a specific 
'Live' instrument in the plant/system.  This simplifies the ability the control the operation of the 
Strategy files held in the instruments, by allowing, 

 the control of existing Application files held in the Instrument Folder from the Project 
Organiser. 

use Startup 

 

The Startup, provides a central environment to launch the WindowViewer (InTouch Application). 

It provides the ability to run a single instance of the WindowViewer (InTouch Application), by 
allowing 

 the startup of all the relevant applications used by the Operations Viewer. 

use System Checking Tool 

The System Checking Tool, provides a central environment to validate an installation and configure 
selected default parameters in a Project.  This simplifies the configuration of the Project and allows 
default parameters to be defined via simple single button and wizard dialog operations. 

Note 
A summary of the system is included, showing the Computer System information and the Products installed. 

 

use Tag Import/Export 

 

The Tag Import/Export, provides a central environment for changing the Tag information.  It allows a 
list of Tags from the Project database to be exported to a .csv/.txt format file.  After editing the 
relevant Tag parameters, this .csv/.txt format file can then be imported into an existing Project 
database. 

Note 
Exporting the list of Tags to either .csv/.txt format file will simplify the operation of editing Tags. 

It is launched by pressing the Tag Import/Export button in the Application Toolbar, available if All 
Tags is selected. 

use Tag Profile 

 

The Tag Profile, provides a central environment to configure a Tag Profile.  This simplifies the 
configuration of the 'Block Type' and 'Point Type' parameters in the Project database. 
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Note 
It is not recommended, but security parameters may also be configured if the system is operating without 

any form of confirmation or security policy. 

It is launched by pressing the Tag Profile button in the large Toolbar, available if All Tags is selected. 

What is a Block Type? 

This is the type of Block, e.g. T800 (Header Block), TOD_DIAG (Diagnostic Block), or MOD_UIO 
(I/O Block) etc., as selected via the LINtools Engineering Studio Template Library. 

Refer to 
the LIN Block Reference Manual for details of each Block Type. 

What is a Point Type? 

The 'Point Type' is used to provide different Profiles on Tags of the same 'Block Type'.  Elsewhere in 
the Project/system (in the Tag editor) a 'Point Type' can be associated with particular Blocks. 

The 'Point Type' is also used to provide a special point display in Operations Viewer but if there is no 
special point display configured it reverts to that defined by the 'Block Type'. 

Note 
There are no fixed rules about how a 'Point Type' can be used in relation to a 'Block Type'. 

use Tag Security Area wizard 

 

The Tag Security Area, provides a central environment to create a reference to a collection of Tags 
that ALL have the same write permission restrictions, as configured by the Access Level User Rights 
in the Security Manager Utility.  This simplifies the ability to create a new reference to a Tag Security 
Area used in the Project/system. 

IMPORTANT NOTE 
The property page allows the name and description to be changed, but if the Tag Security Area is renamed it 

must also be changed in Security Manager. 

use Tag wizard 

 

The New Unattached Tag wizard, provides a central environment to create a placeholder that can be 
attached using the Attach Tag command.  This simplifies the ability to create an Unattached Tag, as 
a placeholder, to identify an individual data field or subfield, a generic I/O point, a LIN function block, 
or a standard LIN Control Module in the Project/system. 

Follow the wizard instructions to create a new Unattached Tag. 

use iTools Engineering Studio 

 

The iTools Engineering Studio, provides a central environment to configure an I/O instrument control 
strategy.  This simplifies the ability the manage and control an I/O instrument control strategy by 
allowing, 

 the parameterisation and commissioning of the Instrument 
 the cloning and monitoring of specific controllers and data acquisition and management 

recorders 

 the editing, and storing of complete controller configurations 
 the configuration of data logging, process monitoring, modbus/TCP (Ethernet) and modem 

connection 
Note 

iTools can operate on a Modbus master and used configure I/O Instruments on a Modbus network using 
Transparent Modbus Access. 
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It is launched by pressing the iTools Engineering Studio button in the Application Toolbar, available if 
the I/O Instrument from a Network is selected. 

use iTools OPC Scope 

The iTools OPC Scope, provides a central environment to configure each Computer and Modbus 
Server used on the relevant Modbus network in the system.  This simplifies the ability to control and 
manage 'Live' data and historical logged data via a DDE link. 

It provides the ability to control and manage the relevant data in the Project database by allowing: 

 the identification of a Computer and its associated Modbus Server 
 the display of 'Live' data from either the manufacturers or third party instrumentation 
 the control of exiting historical logged data. 

use WindowMaker 

 

WindowMaker provides a central environment for creating displays on a computer to show required 
values and alarms in specific parts of a Project/system.  HMIs (displays) then use the companion 
application, WindowViewer, to display real-time data to the operators of the equipment.  
WindowMaker is launched by pressing the WindowMaker button in the large toolbar, available if 
Displays is selected. 

 Alternatively, select 
Start > Programs > Wonderware > WindowMaker 

Note 
If the project was created as a Managed Application (Plant Solution with Operations - ArchestrA, or 

Modbus I/O with Operations - ArchestrA), then the project must be edited through the Archestra IDE.  
Within the ArchestrA IDE, use the FoxboroPAC > Configure EurothermSuite Apps menu option (or click 

the Manage EurothermSuite Applications toolbar icon) and then click the Edit button. 

Refer to the Wonderware documentation for details. 

 

Wonderware Build ToolBar 

This ToolBar hosts icon buttons that enable quick access to the Tools used for configuring the 
selected parameters. 

Tip! 
Cut, Copy, Paste and Delete button commands are only available if specific conditions are correct. 

 

Wonderware Build ToolBar 

 

use Wonderware Build 

, or  

The Wonderware Build Tool, provides a central environment for listing any error or warning, ensuring 
the information in the Project database remains up to date and accessible to the Wonderware 
Application.  This simplifies the ability of manage and control the parameters required by 
Wonderware InTouch Application by allowing, 

 confirmation that the various levels of the Project are correct 

 the cause of any error or warning to be indicated 
This Tool is opened by pressing the Wonderware Build button in the Application Toolbar, available at 
all times. 
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Deploy ToolBar 

This ToolBar hosts icon buttons that enable quick access to the Tools used for configuring the 
selected parameters. 

Tip! 
Cut, Copy, Paste and Delete button commands are only available if specific conditions are correct. 

 

Deploy ToolBar 

 

use Deploy Database 

 or  

The Deploy Database, provides a central environment to allow the deployment of the Project 
Database and/or Security Database.  This simplifies the ability the manage and control active 
databases allowing parameters, 

 to be collated into the master database 

 to be transferred to a specific destination 
It is launched by pressing the Deploy Database button in the Application Toolbar, available if the 
Project is defined as the currently active Project, via the Project Properties dialog. 

Tip! 
If the Deploy Database button is disabled the Project is not defined as the active project. This 

disables the deployment of the Database, and access by the InTouch application. 

Project Database Deployment 

If deploying a Project Database, the InTouch Application can be controlled from the Project 
Deployment dialog shown when the View button is pressed.  This also shows a log and summary of 
the database revision. 

Security Database Deployment 

If deploying a Security Database, specific Security zones can be defined from the Security 
Deployment dialog shown when the View button is pressed.  This also shows a log and summary of 
the database revision. 

 

Tree View 

The Tree View is used to represent a Project using the set of pre-defined  items.  It is 
separated into a Tree View, showing the Project folder and the items, and a default Drop 
Target area.  Generally, additional items must be created to simplify the configuration of 
the Project. 

Note 
Tags are NOT shown in the Tree View. 

 

Items 

The Tree View shows the Project folder and the items, each dedicated to a particular type of 
processing operation.  Some may require additional configuration, with each subsequent item used 
as a destination when assigning Tags, if sufficient targets have already been created. 

Note 
System container only appears when Tag Browser view is selected. 
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Drop Target 

The Drop Target area displays a single destination.  It is used to define a single point in 
the Project, simplifying the movement of items and Tags in a Project. 

Drop Target 

The Drop Target is a container, below the Tree View.  It allows a selected Tag(s) to be quickly 
assigned to a single specified location, avoiding any search through the Tree View. 

Tip 
The Drop Target is particularly useful when the Tree View is becoming very large.  When you right-
click on an item and select "Set As Drop Target" the item will appear in the Drop Target window.  If 

the user double-clicks on the drop target it will locate the item in the tree view and select it. 

 Use the floating menu to configure the Drop Target. 
 

Tag View 

The Tags used throughout the Project can be shown in either List View or Report View.  Both views 
allow individual or multiple Tags to be moved or copied (assigned) to an item in the Tree View.  It 
can also be used to further refine the view of the Tags in the Project, via the Project Organiser View 
or Tag Browser View. 

Tip! 
Assign Tags by dragging from the Tag Browser and dropping them in the relevant Tree View item. 

 It also has full functionality for Attaching, Detaching, Deleting and Editing Tags using the relevant 
commands. 

The list of Tags in either view can be filtered into, All Tags used in the Project, or only I/O Tags using 
the relevant View menus.  However, the System Tags will not be displayed if View > I/O Tags Only 
or View > Project Organiser View is selected. 

 

List View 

The List View is simply ALL the Tags in the Project sorted by name only.  There is no additional 
information displayed, i.e. Tag type, Description, or Reference. 

 

Report View 

The Report View is ALL the Tags in the Project sorted by name, or other view requested by the user, 
allowing the required Tag(s) to be easily located.  It also shows additional information about the Tag, 
i.e. Tag type, Description, or Reference. 

 

System Tags 

The System Tags, as shown in the Tree View, is a list of Tags available in the system.  When the 
Tag Browser View is selected the Tags in the Project are displayed as a list in the main display of 
the window. 

Note 
The list of Tags can be filtered into either, All Tags used in the Project, or I/O Tags only using the relevant 
View command.  However, the System Tags will not be displayed if View > I/O Tags Only or View > Project 

Organiser View is selected. 
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Status Bar 

The Status Bar displays specific Editor information.  It is displayed by default and is 
located along the foot of the screen. 

 
 

Master UNC Path 

The Master UNC Path allows the User to identify the Universal Naming Convention (UNC) path to 
the Project database, also shown in the Project Properties, and MUST be correctly configured in 
order to successfully deploy the Project database. 

Note 

The Master UNC Path for the Security Database is configured in Security Manager 

 

Description 

This shows a brief description of the item selected in the Tree View. 

Some items contain a Description field in the Property page.  Use this to edit the description shown 
in the field. 
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5. How to... 

create a Tag 

An unattached Tag can be configured to represent, 

 any Generic Tag, including 
• an individual data field or subfield, 
• a generic I/O point, 
• a LIN function block, 
 or a standard LIN Control Module Tag. 

Note 
Unattached Tags can only be created if operating in Project Organiser View and remain 

a placeholder until configured, see How to edit Tags. 

Tip! 
It is possible to import, or export, Tags and the configured Tag information from 
a .csv file using Tag Import/Export.  A .csv file simplifies the editing of the Tag 

information, and can be imported easily into the Project. 

Click here to launch the New Tag Demonstration 

1. With the All Tags expanded, create a Tag(s) to represent the required function. 

• Select the All Tags in the Tree View to show the floating menu and select 
New Unattached Tag. 

2. The command initiates the New Unattached Tag wizard.  In the Tag Name field, 
type in a short (12 characters maximum) easily identifiable name for the Tag using any of 
the following characters a z, A Z, 0 9, &, _, -. 

Tip! 
For clarity, use an easily identifiable name, (FCV5-1-1 – Flow Control Valve at 
position 5 1 1).  It is good practice to use a name that corresponds to its use 

and location in the physical model layout. 

3. Select to accept the Tag name.  Press Cancel, , or Esc. on the 
keyboard to abort the operation. 

Note 
Only Block Tags are displayed in the Project Organiser View.  To view all Tags in the 

system select the Tag Browser View. 

4. Configure the Tag as required. 
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create a Network 

A Network represents the communications link between Instruments and/or Computers within the 
system. 

Note 
If Networks have been configured using the LINOPC Control Panel before the Project was created, the 

Networks will automatically appear.  However, an existing system Network can be uploaded using the Clone 
Network wizard. 

Click here to launch the New LIN Network Demonstration 

Click here to launch the New Instrument Network Demonstration 

1. With the Networks expanded, create the Network(s) to define the communication methods 
between Instruments and/or Computers within the system, 

• Select Networks in the Tree View to show the floating menu and select New Network. 
2. The command initiates the New Network wizard.  In the Network Name field, type in a short 
easily identifiable name for the Network using any of the following characters a z, A Z, 0 9, &, _, -and 

press  to continue. 

3. Select the type of Network required. 

• Local Instrument Network (LIN) supports peer to peer communications with Computer’s and 
instruments with LIN database files. 

• MODBUS supports communications between Tactician Instruments and the I/O system with 
single Wonderware InTouch Operations Viewer. 

• PROFIBUS supports communications between Tactician Instruments and the I/O system. 
• EI-BISYNCH supports communications with PC3000 devices including 2000 series 

Controllers. 

4. Press   and select the Port Name required. 

If the Network Port Names have NOT yet been configured for Online Download and Debugging, 
select the Ports Setup button and follow the wizard instructions. 
This can be configured later via the Network Properties dialog. 

Note 
This information is NOT used by the Project, ONLY for easy access to monitoring and download. 

Remember 
In a distributed system, it is useful to set the Remote Machine Name to be a Server that has access 

to that Network through the Port Name entered (this does not have to be available from the drop 
down list).  This allows access to the same features from any Computer in the system, if the 

required setup is correct. 

5. Select to accept the Network name. Press Cancel, or  to abort the 
operation. 

6. Refresh the display, (View > Refresh (F5)). 

7. Now create Instruments. 

Note 
Deleted items are held in a directory and can only be permanently deleted via Windows Explorer, opened 

using Project > Explore Project. 
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create a LIN Instrument 

An Instrument represents the specific hardware used in the system. 

Note 
If the Networks and Instruments of a system are already installed, the information can be uploaded using the 

Clone Network wizard. 

Click here to launch the New Instrument Demonstration 

1. With the Networks expanded, create the Instrument(s) to represent the hardware used on 
each of the configured Networks within the system, 

• Select an existing Network in the Tree View to show the floating menu and select 
New Instrument. 

2. The command initiates the New Instrument wizard.  In the Instrument Name field, type in a 
short easily identifiable name for the Instrument using any of the following characters a z, A Z, 0 9, &, 

_, -, and press  to continue. 

Tip! 
Use the Instrument type and LIN node address as the Instrument name.  This will help clarify 

Tagnames. 

3. The wizard now requests the type of LIN Instrument, including Version and Node Address, 
associated with the Instrument name. 

4. Enter Database Name and Default DBF if required. 

Note 
The Create Build List and User Layer DBFs option MUST be selected if intending to use the Utilities to 

allocate I/O Tags to 2500 instruments attached to T800/T940 LIN Instruments. 

5. User Layers create one LIN Database from several more manageable configurations. This 
enables you to configure smaller simpler strategies rather than one complex multi-compounded 
strategy. 

6. Build List indicates to the system which User Layers to use for creating the output LIN 
Database. 

7. Select  to accept the Instrument name and parameters, and close the wizard. 
 Press Cancel, or  to abort the operation. 

Note 
Additional networks, generally Modbus or Pofibus, can be created for Serial communications from a LIN 

instrument.  An EI-BiSynch network is supported by a limited range of instruments. 

8. Refresh the display, (View > Refresh (F5)). 

Note 
Deleted items are held in a hidden directory and can only be permanently deleted via Windows Explorer 

opened using Project > Explore Project. 
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create a Modbus/Profibus Network Instrument 

A Modbus or Profibus Network Instrument represents the specific hardware used in the system. 

Note 
The Network Instrument wizard is used to automatically generate and configure the DCM blocks required by 

a Modbus or Profibus Network Instrument for communicating with a LIN Instrument.  This is ONLY supported 
by the following 2500 instrument versions, 2500 (2 Loop 2500), 2580 (8 Loop 2500), and 25F0 (SYSIO – Fast 

IOC. No Loops or Toolkit). 

Beware 
The T800 and T940(X) use PROFIBUS addresses, (T800 default address 1 and T940 primary 

processor address 2, secondary processor address 1 if installed).  Make sure that you do not duplicate 
addresses on the communications line.  Configure T800 addresses in its Comms Setup screen and T940 in 

its _SYSTEM.OPT file. 
For Modbus communications, the T940 address (if configured as Modbus Master) MUST always be 0 (zero). 

Click here to launch the Modbus/Profibus Network Instrument Demonstration 

1. With the Networks expanded, create the Instrument(s) to represent the hardware used on the 
configured Network within the system, 

• Select an existing Network in the Tree View to show the floating menu and select 
New Instrument. 

2. The command initiates the New Instrument wizard.  In the Instrument Name field, type in a 
short easily identifiable name for the Instrument using any of the following characters a z, A Z, 0 9, &, 

_, -, and press  to continue. 

3. The wizard now requests the type of Instrument, including Version and Slave Address, and a 
Clone File Template, if available. 

Note 
The Slave Address entry is used by the DCM Blocks ‘Instr_No’ field in the LIN Instrument above this 

Network. 

4. Enter the Default uic filename, if required. 

5. Select  to accept the Instrument name and parameters, and close the wizard. 
 Press Cancel, or  to abort the operation. 

Note 
Deleted containers are held in a hidden directory and can only be permanently deleted via Windows Explorer 

opened using Project > Explore Project. 
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create a Process Cell 

A Process Cell represents a sub-division of the plant that is generally an essential part of 
the final product. 

Click here to launch the New Process Cell wizard Demonstration 

1. With the Plant Model expanded, create the Process Cell(s) to break the plant into 
sub-divisions of more or less self contained areas by; 

• Select the Plant Model in the Tree View to show the floating menu and select 
New Process Cell. 

Note 
Only the Unallocated container exists in the Plant Model, prior to creating a Process 

Cell. 

2. The command initiates the New Process Cell wizard.  In the Process Cell Name 
field, type in a short (16 characters maximum) easily identifiable name for the sub-division of 
the plant (Process Cell) using any of the following characters a z, A Z, 0 9, &, _, -. 

Tip! 
For clarity, try to use an easily identifiable name for an object, i.e. Plant-

Supervisor (Tag Security Area), Feedwater_preht (Plant Unit). 

3. Select   to accept the Process Cell name. Press Cancel, or  to abort 
the operation. 

4. Now create Plant Units. 

5. Refresh the display, (View > Refresh (F5)). 

Note 
Additional description can be entered via the Properties dialog, selected from the 

floating menu. 
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create a Plant Unit 

A Plant Unit represents a sub-division of a Process Cell that is generally a major 
processing activity within the Process Cell, and typically centred on a major piece of 
processing equipment. 

Note 
Plant Units with a unique first 8 characters containing ONLY IO Tags will create 
monitor layers for DCM 2500 blocks that must be assigned using IO Manager. 

Click here to launch the New Plant Unit wizard Demonstration 

1. With the Plant Model expanded, create the Plant Unit(s) to divide the Process Cell 
into the sub-divisions that act independently of the other Plant Units in the Process 
Cell; 

• Select the Process Cell in the Tree View to show the floating menu and select 
New Plant Unit. 

Note 
Only the Unallocated container exists in the Plant Model, prior to creating a Plant Unit. 

2. The command initiates the New Plant Unit wizard.  In the Plant Unit Name field, 
type in a short (16 characters maximum) easily identifiable name for the Plant Unit (a sub-
division of the Process Cell) using any of the following characters a z, A Z, 0 9, &, _, -. 

Tip! 
For clarity, try to use an easily identifiable name for an object, i.e. Plant-

Supervisor (Tag Security Area), Feedwater_preht (Plant Unit). 

3. Select   to accept the Plant Unit name.  Press Cancel, or,  to abort 
the operation. 

4. Now assign Tags. 

5. Refresh the display, (View > Refresh (F5)). 

Note 
Additional description can be entered via the Properties dialog, selected from the 

floating menu. 
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create an Alarm Group 

An Alarm Group is a collection of Tags that are required to report an alarm state to the 
Alarm Provider.  The Alarm Group name, when displayed in the Alarm banner in the 
InTouch Supervisory Computer, describes the location and other specified data about the 
Tag that instigated the alarm. 

Note 
A new Alarm Group is created using the same principle as the Process Cell and Plant 

Unit. 

Click here to launch the New Process Cell wizard Demonstration 

1. With the Alarm Group expanded, create the Alarm Group(s) to break the plant into 
sufficient identifiable groups; 

• Select the Alarm Group in the Tree View to show the floating menu and select 
New Alarm Group. 

Note 
Only the Unallocated container exists in the Alarm Group Editor, prior to creating an 

Alarm Group. 

2. The command initiates the New Alarm Group wizard.  In the Alarm Group Name 
field, type in a short (12 characters maximum) easily identifiable name for the Alarm Group 
using any of the following characters a z, A Z, 0 9, &, _, -. 

Tip! 
For clarity, try to use an easily identifiable name for an object, i.e. Plant-

Supervisor (Tag Security Area), Feedwater_preht (Plant Unit). 

3. Select to accept the Alarm Group name. Press Cancel, , or Esc. on 
the keyboard to abort the operation. 

4. Refresh the display, (View > Refresh (F5)). 

Note 
Additional description can be entered via the Properties dialog, selected from the 

floating menu. 
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create an Alarm Group Set 

An Alarm Group Set is a collection of Alarm Groups (including assigned Plant Units and 
Tags) that are required to report an alarm state to a specific InTouch Supervisory 
Computer. The Alarm Group Set contains all the Alarm Groups you wish to display in the 
Alarm banner of the specific InTouch Supervisory Computer, describing the location and 
other specified data about the Tag that initiated the alarm. 

Note 
A new Alarm Group Set is created using the same principle as the Process Cell and 

Plant Unit. 

Click here to launch the New Process Cell wizard Demonstration 

1. With the Alarm Group Set expanded, create the Alarm Group Set(s) to break the 
Project down into sufficient identifiable groups, 

• Select the Alarm Group Set in the Tree View to show the floating menu and select 
New Alarm Group Set. 

Note 
Only the Unallocated container exists in the Alarm Group Editor, prior to creating an 

Alarm Group Set. 

2. The command initiates the New Alarm Group Sets wizard. In the Alarm Group Sets 
Name field, type in a short (12 characters maximum) easily identifiable name for the Alarm 
Group Set using any of the following characters a z, A Z, 0 9, &, _, -. 

Tip! 
For clarity, try to use an easily identifiable name for an object, i.e. Plant-

Supervisor (Tag Security Area), Feedwater_preht (Plant Unit), Plant-Svisor 
(Alarm Group Set). 

3. Select to accept the Alarm Group Set name. Press Cancel, , or Esc. 
on the keyboard to abort the operation. 

4. Refresh the display, (View > Refresh (F5)). 

Note 
Additional description can be entered via the Properties dialog, selected from the 

floating menu. 
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create a Tag Security Area 

A Tag Security Area is a collection of Tags that ALL have the same write permission 
restrictions, as configured by the Access Level User Rights in the Security Manager Utility. 

Note 
A new Tag Security Area is created using the same principle as the Process Cell and 

Plant Unit. 

Click here to launch the New Process Cell wizard Demonstration 

1. With the Tag Security expanded, create the Tag Security Area to break the Project 
down into sufficient identifiable groups, 

• Select the Tag Security in the Tree View to show the floating menu and select 
New Tag Security Area. 

Note 
Only the Unallocated container exists in the Tag Security Editor, prior to creating a Tag Security Area. 

2. The command initiates the New Tag Security Area wizard.  In the Tag Security Area 
Name field, type in a short (12 characters maximum) easily identifiable name for the Tag 
Security Area using any of the following characters a z, A Z, 0 9, &, _, -. 

Tip! 
For clarity, try to use an easily identifiable name for an object, i.e. Plant-

Supervisor (Tag Security Area), Feedwater_preht (Plant Unit). 

3. Select to accept the Tag Security Area name. Press Cancel, , or 
Esc. on the keyboard to abort the operation. 

4. Refresh the display, (View > Refresh (F5)). 

Note 
Additional description can be entered via the Properties dialog, selected from the 

floating menu. 
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create a Computer 

A Computer represents the focal point for the display of selected Alarm Group Set(s), simplifying the 
control of visible alarms at any particular computer.  By creating a Computer in Project Organiser, it 
is automatically included in the list of Computers that will receive updated Project and/or Security 
databases when deployed. 

Note 
Multiple Alarm Groups Sets can be allocated to any configured Computer. 

Click here to launch the New Computer Demonstration 

1. With the Computer expanded, create the Computer(s) to define a focal point for the display of 
Alarms generated from a configured Alarm Group Set. 

• Select Computer in the Tree View to show the floating menu and select New Computer. 
2. The command initiates the New Computer wizard.  In the Computer Name field, type in a 
short easily identifiable name for the Computer using any of the following characters a z, A Z, 0 9, &, 
_, -. 

• Select the Server to indicate that the Computer is operating as an Alarm Provider. 

3. Select   to accept the Computer name.  Press Cancel, or  to abort the 
operation. 

4. Refresh the display, (View > Refresh (F5)). 

Note 
Ports will be automatically displayed if already configured using the Configured LIN Ports Tool.  However, 

the overall Computer item may need further configuration, i.e. Access Names (configured via Project 
Configuration), and each individual Computer may require specific configuration, i.e. Redundant Partner 

configuration via the Property page. 

Click here to launch the Configure Computer Demonstration 

Click here to launch the New Port Demonstration 
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create a Display 

A Display represents a user generated screen used to illustrate a mimic within the Operations 
Viewer. 

Click here to launch the New Display Demonstration 

1. With the Displays expanded, create the Displays to illustrate a mimic in the Operations 
Viewer. 

• Select Displays in the Tree View to show the floating menu and select New Displays. 
2. The command initiates the New Displays wizard. 

i. In the Display Block Name field, type in the name of the Instrument. 
ii. In the Mimic Name field, type in a short easily identifiable name for the SCADA mimic 

associated with this display block using any of the following characters a-z, A-Z, 0-9, &, _, -. 

3. Select   to accept the Display name.  Press Cancel, or  to abort the 
operation. 

4. Refresh the display, (View > Refresh (F5)). 

5. Now configure the Page Navigation for the selected Display. 

• Select Displays in the Tree View to show the floating menu and select Properties. 
The Properties of each display has the Display Block page and the Display Navigation page. 

i. The Display Block Page is specifies the Display and Mimic Name of the selected object.  It 
can be used to configure the level of security required to view this page and define it as a 
Process Cell Display for use in the Process Cell page parameter.  The Process Cell, Alarm, 
and Trend Page parameters are used to define the Display block to be shown when the 
corresponding InTouch Application button is pressed. 

Note 
A Process Cell Page must be configured as such using the Process Cell Display checkbox. 

ii. The Display Navigation parameter is used to configure the Display Block to be shown from 
the selected Display in the InTouch Application when the specified navigation button is used. 

6. Build the Project and Deploy as appropriate. 

Click here to launch the Configure Display Demonstration 

create a Trend 

The Trended object is simply a container for different trend objects that contain Tags.  The Trended 
is used to control and manage the object Tags that are used to define values that are to be 
recorded. 

A Trend is not created as such, but by allocating Tags to the InSQL Trended Tags, or the InTouch 
Trended Tags item, the value referenced by the Tag can be plotted and displayed on a Trend of the 
assigned type. 

set the Drop Target 

This is actually defining a common destination, for an item or Tag, that appears at the foot of the 
Tree View.  This simplifies the system configuration between source item(s) or Tag(s) and the 
destination. 

How to... 

1. With the source item selected in the Tree View, expand (click ) it to display the items 
contained within, as necessary. 

2. Select (click on) the required destination item in the Tree View to reveal the floating menu. 

3. Select Set as Drop Target command. 

4. Observe as the selected item appears at the foot of the Tree View. 

5. Configure the Tags, as necessary. 
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assign Tags to an item 

This is actually simply adding the reference of a Plant Unit, Tag Security Area, Alarm 
Group or Alarm Group Sets item to the properties of the Tag, but is simplified by dragging 
a Tag from one location to another.  This allows the configuration Tools to access the 
applicable Tag data when required. 

Note 
Project Organiser will not permit Tags to be assigned to a destination that is not 

relevant.  An Invalid destination is indicated by the  symbol 

Tags can be assigned to any item.  A Tag can be dragged from the Tagname column and 
dropped in the Tree View, therefore assigning the Tag to that item. 

Tip! 
Use the 'Set As Drop Target' command from the floating menu in the Tree View 

to define a regularly used destination. 

Click here to launch the Assign Tags Demonstration 

1. With the appropriate item open, select the required Tag.  If necessary, 

• expand and/or collapse the required items in the Tree View 
• select the required View, i.e. to show only I/O Tags select View > I/O Tags Only, 

alternatively selecting the View > Tag Browser to show Tag 
2. Assign a Tag to the desired location. 

i. Select (click on) a Tag from the Tagname column, in the Tag Browser, to highlight 
it. 

Tip! 
Hold down the <Ctrl> key and select (click on) other Tags to add to the multiple 

selection. 

ii. Drag the Tag(s) to the appropriate item in the Tree View. 
iii. Release the mouse button when the Tag is located in the relevant destination. 

Note 
The destination can also be the Drop Target. 

3. Press F5 to refresh the window.  The system and List View now recognise the 
configured Tag(s). 
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assign another function to an item 

This is actually adding a reference of a different function to the properties of the Tag, or 
group of Tags as defined by Plant Units, Alarm Groups, Alarm Group Sets, Tag Security 
Areas, but is simplified by dragging an item from one location and dropping in an 
additional destination.  This allows the configuration Tools to access the applicable Tag 
data when required. 

Note 
These instructions apply when assigning any container to an appropriate destination. 

 An Invalid destination is indicated by the  symbol. 

How to... 

1. With the source item selected in the Tree View, expand (click ) it to display the 
items contained within, as necessary. 

2. Assign an item to the desired location. 

i. Select (click on) a item in the Tree View to highlight it. 
Tip! 

Hold down the <Ctrl> key and select (click on) other items to add to the multiple 
selection. 

ii. Drag the item(s) to the required destination, in the Tree View. 
iii. Release the mouse button when   appears below the cursor. 

Note 
Using the Copy and Paste commands will have same result. 

3. Press F5 to refresh the window.  The system and List View now recognise the 
configured Tag(s). 
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edit Tags 

When first created the Tag is simply a placeholder, and remains a placeholder until 
configured.  All Tags, including Control Module Tags have field values that may be 
configured using the TagEdit Dialog. 

The TagEdit Dialog is divided into pages, each consisting of applicable fields that are 
references in the Project database. 

Note 
The Tags in the system can be filtered using the appropriate View commands. 

Click here to launch the Edit Tag Demonstration 

1. Select the Tag, and from the floating menu select Edit Tag. 

2. Select the page containing the field value you wish to change. 

• General page fields are cross references to plant data. 
Changing the TagName does NOT automatically change the LIN Block name. 
 Type, Units, or Descriptions can be changed using the Tag Import/Export Tool. 

• SCADA page fields are cross references to fields used by InTouch Supervisory 
Computer during run-time. 

Ranges (These are Trend Ranges only – engineering ranges have already been 
configured in iTools).  InTouch FacePlate, Point Display, Home Page can be 
changed using the Tag Import/Export Tool. 

• Network page fields are cross references to Network specific data. 
The LIN Block name can be a maximum of 8 characters only, changing this does 
NOT automatically change Tagname. 

• LINData page fields are cross references to LIN Instrument specific data. 
The LIN Block Fields and Alarms. Changes made here will be written to the Project 
database (for I/O) or the LINTools configuration file as appropriate.  This page 
provides access to live data via the Computer servers configured in Computers. 

Note 
Online data, enabled via the checkbox, comes from the Computers.  The first server is 

used whether it is Online or Offline regardless of redundancy. 

• IO Data page fields are cross references to I/O Instrument specific data, if 
displayed. 

The iTools clone file fields. Changes made here will be written directly to the iTools 
clone file and provides access to live data via the online port configured in the 
Modbus/Profibus Network folder for that 2500 instrument. 

Note 
Online data, enabled via the checkbox, comes from the Online Port settings configured 

in the Modbus or Profibus Network folder for the associated 2500 Instrument. 

3. Double click the value.  A keyboard or a pick-list is revealed on-screen. 

Tip! 
Select the Any Generic Type if unsure of its use.  If this Tag is used in a 

container that requires a specific type, the Tool will automatically update the 
Project database to reflect the specific type appropriate to the Tags use. 

4. Edit the parameter as appropriate, 

• using the keyboard, enter the required value and press return to accept 
• using the picklist, select the required value and press OK to accept 

Note 
Values can be entered and accepted via either the on-screen or hardware keyboard. 

The field value has changed, automatically updating the Project database. 
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5. Press to accept the changes. 

6. Press F5 to refresh the window.  The system and List View now recognise the 
configured Tag(s). 

find objects 

When selected this command displays a dialog used to locate all occurrences of the 
specified sequence of characters used in a specified criteria. 

The result list initially shows the full Name of the items that match the specified sequence 
of characters, the Type of the item and it’s location in the Tree View in the order they are 
found.  This list can be sorted in alphabetical ascending or descending order with respect 
to any of the result columns by clicking on the column heading. 

The item can be displayed immediately, simply by double-clicking the desired item. 

Tip! 
Only enter part of the required sequence of characters to broaden the results. 

1. Simply, select (click on) Edit > Find. 

• Alternatively, press Ctrl+F. 
2. The command displays the Find dialog.  In the Item to Find field, type in the string of 
characters corresponding to the item you wish to find. 

i. To refine the search parameters, press Options >> to reveal additional search 
parameters that allow a more specific search. 

Note 
The Options >> button changes to << Options if additional search parameters are 

displayed. 

ii.  (check) the Exact Matches Only check box to further restrict the search to only 
items that matches the string of characters defined in the Item to Find field. 

iii.  (check) each Item Type you wish to find that matches the string of characters 
defined in the Item to Find field. 

iv.  (check) each Location type you wish to search for the item that corresponds to 
the string of characters defined in the Item to Find field. 

Note 
Items matching the string of characters defined in the Item to Find field, that are of the defined Item Types, 

and in the specified Location area(s) will be shown in the results list. 

3. Press Find to initiate the search for items containing the string of characters defined 
in the Item to Find field. 

• The results list updates as each matching object is found. 
Tip! 

Double click the required result to display it in the Editor Contents Region and 
close the Find dialog. 

4. Press Close, , or Esc. on the keyboard to abort the operation and return to the 
Project Organiser. 

5. Press F5 to refresh the window.  The system and List View now recognise the 
configured Tag(s). 
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refresh the display 

This is an important command, as any amendments to the system will not be displayed 
until it has been informed of the changes (refreshed). 

To update the system and List View with the latest information from the Project database, 

1. View the Project using either, Project Organiser or Windows Explorer, 

2. Then, refresh the system by, 

• at any point, press F5 
• on the Menu Bar, select View > Refresh 
• in the Tree View, right click to show the floating menu and select Refresh 
• in the List View, right click to show the floating menu and select Refresh 

 

build the Project 

 

This MUST be the final operation when configuring a Project, as the Project database only 
contains the function blocks needed for processing the live LIN, I/O and the control 
modules.  Before the Project is built, the Project database remains in a provisional 
condition, due to its lack of any configured information used by the control strategy.  These 
are incorporated into the Project database and displayed in the Project Namespace. 

Tip! 
Use the BUILD command to ensure the Project Database contains all the latest 

configuration changes before the system is started. 

1. With the Project open, select the Project folder. 

2. Press the Build button. 

3. This command displays an animated progress dialog, and when complete a Build 
Window.  The window displays each step of the Build process indicating errors and 
warnings as it progresses.  Once complete, the last line of the Build states the total 
number of errors and warnings found. 

Tip! 
Double-click an error entry to automatically launch the Utility required to correct 

the problem. 
 

Project Namespace 

The Project namespace is a structured collection of folders and files that together form a Project. 
 The Wizards supplied create the standard folders (e.g. Networks) and Editor’s (e.g. Plant Model and 
Security Manager).  The user can add folders and files to hold related documentation for the Project, 
such as operations manuals, design specifications, drawings etc. into any appropriate place in the 
structure. 
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build the Wonderware parameters 

indicates that the changes to the Project must be applied to the Wonderware 
Application. 

indicates that the Project does not contain changes that effect the Wonderware 
Application. 

This is only applicable to changes in the Project that relate to the Wonderware Application, 
i.e. Access Names, and InTouch Trended Tags. 

Tip! 
Use the Wonderware Build to ensure that changes to the Project that effect the 

Wonderware Application are accessible. 

1. With the Project open, select the Project folder. 

2. Press the Wonderware Build button. 

3. This command displays an animated progress dialog, and when complete a Build 
Window.  The window displays each step of the Build process indicating errors and 
warnings as it progresses.  Once complete, the last line of the Build states the total 
number of errors and warnings found. 

 

deploy the database(s) 

indicates that either one or both Project and Security databases must be deployed. 

indicates that both Project and Security databases are currently unchanged, and the 
databases do not need to be deployed. 

Click here to launch the Deploy the database Demonstration 

How to... 

1. The Project and/or Security databases can be deployed to all or selected destinations, 
depending on the changes that exist. 

2. After pressing the Deploy Database button from the Toolbar, the Deployment Summary 
dialog appears.  This offers a brief count of the statistics for each database.  Click the 
appropriate button to continue. 

- If the (Project) Deploy button is pressed, the database is deployed to all computers 
configured in the Computers container.  If the (Security) Deploy button is pressed, the database 
is deployed to all Security items defined in the Security Manager. 

• Confirmation is required when complete. 

- If the (Project) View button is pressed, the Project Deployment dialog appears.  This 
offers control of the InTouch Application via the Start, Stop, and Restart buttons, and also 
shows a log and summary of the database revision.  If the (Security) View button is pressed, the 
Security Deployment dialog appears.  This offers control of the destination Security zones and 
also shows a log and summary of the database revision.  The Deploy All and Deploy buttons 
initiate the Deploy process, and the Exit button closes the Deploy process and returns to the 
Deployment Summary dialog. 

3. Press   to deploy both databases to all configured destinations. 

4. When the Deployment has been successful, press  to terminate the deployment 
command. 
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Deployment Summary dialog 

The Deployment Summary dialog is displayed to allow the ‘deployment’ of the Project and/or 
Security database of an active Project to selected nodes. 

It is displayed after selecting the  button from the Deploy ToolBar. 

 

What is Deployment ? 

Deployment is a method of automatically gathering remote node ‘Project and/or Security databases’, 
collating and updating the master database with the latest relevant information and downloading it to 
selected destinations in the system configuration.  It is divided into ‘Reconciliation’ and ‘Download’ 
steps. 

 Reconciliation collates the operational revisions from selected databases and retains them in 
the master database.  The configuration revision of the master database is updated and 
allocated the next highest number. 

 Download issues the latest configuration revision of the master database to the selected 
client databases. 
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6. Getting specific help 

Project Organiser help 

To get help on using Project Organiser, click the shortcuts: 

 All Tags 
 Networks 
 Plant Model 
 Alarm Groups 
 Alarm Group Sets 
 Computers 

 Tag Security 
 Displays 
 Trended 

To get help on individual Project Organiser container: 

In the relevant Project Organiser area, click on a item and press <F1> to display this help window. 

You can see information relevant to the selected item: 

 Some items will display property dialogs, allowing additional configuration. 
Note 

Each Application launched from Project Organiser has its own relevant help files. 
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